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CHAPTER 1

Introduction

This chapter introduces the features and capabilities of the software.  It offers a useful 
overview of different parts of the software.

Software Overview

The SyncLights software package specializes in sequenced control.  It allows users to 
specify, simulate, and execute timed sequences of events.  While fairly versatile, the 
software was initially developed to target holiday lighting displays.  When deployed in 
this type of application, the software can be used to do the following:

• Plan and virtually depict a holiday lighting setup.
• Create timed sequences to control individual lights synchronously with music.
• Simulate specified sequences within the software to validate the actual visual 

effects against specified music.
• Play sequences to control actual hardware.
• Define and schedule play lists to loop through sequences and their associated 

songs automatically during certain hours of the day.
• Remotely control individual channels and/or start sequences.

FIGURE 1-1: Overview of software 
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As Figure 1-1 shows, SyncLights is capable of managing a list of control channels (far 
right).  Each channel ultimately corresponds to a unique hardware element (far left). 
When a recorded sequence is specified, every channel can be independently assigned an 
on or off state at discrete times.  During execution of a programmed sequence, the 
specified states are applied in real time as the sequence progresses.  The sequence states 
can be set to control actual hardware or visually simulate the hardware changes using the 
SyncLights’ software simulator.

By offering simulation, SyncLights enables the user to design sequences without the need 
for actual hardware.  This is particularly valuable since hardware may not always be 
available or easily accessible.  This makes development during down time or off-season 
possible when applied to seasonal displays.  Once a sequence is designed and verified 
using simulation, the file can later be played back and target actual hardware exactly as 
planned.  

The software supports multiple channels, hardware control interfaces, and recorded 
sequences.  This enables it to be used for both small and large applications.  Multiple 
sequences can also be specified and optionally associated with separate songs or other 
multimedia files.  These sequences can then be replayed individually or collectively by 
defining playlists composed of multiple sequences. 

Software Capabilities

The software has been designed with flexibility in mind.  It has been architected to 
support the addition of future enhancements to meet growing needs and applications. 
The current feature set is based upon immediately identified needs.  Additional 
capabilities can be negotiated and added per request.  Please contact the developer to 
discuss arrangements for customization or even to recommend a suggested feature for 
future consideration.

The software currently supports the following:

• Control Channels
o Up to 32,768 separate control channels can be defined.  Practical 

limitations may dictate far fewer actual channels due to the complexity 
required in managing such a large number of channels for simulation 
purposes.

o Individual hardware interfaces methods may further restrict the number of 
hardware channels that can be controlled at a given time.  Additional 
channels can be defined, but may not necessarily be accessible in 
hardware due to potential hardware limitations.

o Control channels can be visually depicted as text or other common holiday 
elements such as trees, snowmen, candy canes, arches, nets, basic shapes, 
etc.
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• Sequences
o Sequences can define individual channel states at either 5 or 10 different 

equally spaced states per second.  Support for other switching rates may 
be added at a later date.

o A waveform editor and TimeStamper tool allow the user to specify 
sequences precisely and easily. 

o Each sequence is stored in a separate file and can be associated with an 
MP3 or other multimedia file that can be played during execution of the 
sequence.

• Playlists
o Multiple sequences can be loaded and automatically stepped through
o A scheduler can be used to turn on and off the system automatically at 

fixed times.
• Remote Control

o Companion software for handheld devices can communicate with the 
primary SyncLights server software if configured with a wireless network 
to kick off sequences or individually test channels.

System Installation

The software can be deployed to target several applications.  One possible system 
arrangement is illustrated in Figure 1-2.  This figure shows a PC running the SyncLights 
Player software and connected to individual channels through distribution hardware.  The 
possible types of hardware depend upon supported hardware interfaces.  Support for 
additional interfaces can be added per request as well.  
 

Figure 1-2: Possible System Arrangement
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The distribution hardware is abstractly depicted in Figure 1-2.  Any hardware with a 
supported interface can be used.  The details regarding the interface will dictate the 
appropriate connection between the PC and the distribution hardware.  Common choices 
include USB, an RS-232 serial port, a parallel port connection, Ethernet connectivity, etc. 
Limitations of the hardware will determine how many channels can be controlled.  Figure 
1-2 only illustrates a small number of channels for simplicity.

In addition to showing the controlled channels, Figure 1-2 also depicts other optional 
peripherals.  These include a means for projecting accompanying audio using speakers or 
an audio transmitter and a wireless network.  The audio connections make it possible for 
viewers to listen to the music that the lights may be synchronized with.  The wireless 
network and PDA are both optional.  If present, they can be used to communicate with 
the server software and act as a remote control.  This is especially convenient to field test 
control channels.
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CHAPTER 2

Quick Start Guide

This chapter is intended to quickly walk through the essential parts of the software to 
enable the reader to quickly begin using the software.  Additional details on specific 
features mentioned can be found in later chapters.

Welcome Wizard

The first time you run the program, a Welcome Wizard will appear to help you setup the 
software.  This utility helps configure a new display quickly.  It can be selected under the 
File menu of the main design screen.  After completing the welcome wizard, the next 
steps involve customizing the channel parameters and create a sequence.  Overall, the 
following steps are involved in starting to use the software:

1. Create new channels.  This can be done using the welcome wizard or manually. 
A channel represents an controllable display element.  For a brief overview of 
manually creating channels, see the Define Control Channels section starting on 
page 10.  

2. Customize the channels to control depiction during simulation or interaction 
during hardware execution.  You can edit each channel type to specify color, type, 
position, size, etc.  This can be done right away or later as needed.  For more 
information, see the Editing an Existing Channel section starting on page 27.  

3. Create a new sequence.  Once the channels are defined, you can create a sequence 
using the Sequence Editor.  A sequence is a programmed set of on/off states.  For 
more information, see the Programmed Sequences and Sequence Editor chapters 
starting on pages 34 and 43 respectively.

4. Once you have partially or completely defined a sequence, you can save the 
changes and simulate it.  See the Simulating Sequences chapter starting on page 
57 for more information.

5. If you have connected hardware, you can execute a sequence to control it.  First 
you need to specify the hardware interface.  See the Hardware Interfaces chapter 
starting on page 59.  You may also need to edit the channels to specify how each 
is accessed in hardware as described for relevant fields in the Creating a New
Channel section starting on page 23.

6. Execute your sequence in hardware.  For more information, see the Executing
Sequences chapter starting on page 65.

The following sections helps to introduce the software and basic usage.  Please refer to 
later chapters for more detailed information.
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The Main Design Screen

The main design screen appears as soon as the SyncLights software runs.  Figure 2-1 
shows this screen.  Depending upon the default settings, you may see a blank background 
or more or less control images.  This design screen is used to specify and organize control 
channels.  It is also used to simulate programmed sequences.  Figure 2-1 only shows one 
control channel.  You may see more or less predefined channels.  As you will see, you 
can create any number of these channels on your own.

Figure 2-1: The SyncLights Player’s Main Design Screen

There are four areas of the main design screen in Figure 2-1 worth highlighting:
1. The first is the menu at the top of the screen.  The menu can be used to select the 

necessary functions to work with the software.  
2. The largest portion of the screen is the design area itself.  This appears in the 

middle.  
3. In the lower left corner, there are control node options.  This includes a list of all 

defined nodes and buttons to edit or create additional nodes.  
4. In the lower right are several status indicators.  These indicators are indicate 

information about remote access, play status, etc. 

Specify a Background Image

When targeting the software for a specific installation, the first step is to define a 
background image.  The image is not strictly necessary, but can be helpful to plan the 
layout of the display if the setting is known.  For example, if the display is going to be 
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setup outside a residence or business, the background could be set to the picture of the 
home or business.  While the background image is recommended because of its overall 
usefulness, it is not required.

To specify a background image, run SyncLights and select Set Background from the File 
menu.  You will be prompted to specify a JPEG image to use as the background.  Find 
the image you wish to use on your computer and select it.  SyncLights will load the 
image and set it as the background.

After placing the image, you may realize that picture is too large or too bright.  You may 
want to edit the image and then reload it.  For more information, please refer to the  
section on page 18.

Tip: Use a picture taken in low light or edit the picture to 
decrease the brightness so that the lighting elements 
appear more distinct against the background. 

More Information: See the Creating a Background Image 
chapter on page 18.

Define Control Channels

Once you have specified a background image or decided to proceed without one, you 
next need to define control channels.  A control channel is an individual element that the 
software can turn on or off.  When defining a channel, you specify how the channel is 
accessed via the hardware interface and how it should be depicted within the software. 
The former is important when controlling actual hardware whereas the latter applies to 
software simulations.

The software may already include defined control channels.  If this is the case, the 
predefined channels can be retained and edited, or removed.  To simply remove all 
defined channels and start from scratch, select Edit Channels List from the Channels 
menu.  A new screen will appear as shown in Figure 2-2.  Select all channels on the left 
by clicking on the first channel in the list and dragging down.  Once all channels have 
been highlighted, press the Delete Selected button.  The list on the left should get 
emptied.  Press Use New Channels to return to the main design screen without any 
defined channels and start from scratch.  
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Figure 2-2: Deleting Control Nodes

To create a new channel, click on the New Channel button in the lower left corner of the 
program or select Create New Channel from the Channels menu.  A new window will 
appear to allow you to configure the channel.  This window is shown in Figure 2-3.

The channel details should be specified in the new window.  At a minimum, the Channel 
Name should be set (e.g. “Tree 1”, “Front Arch”, or “Little Snowman”) and the Channel 
Type should be selected.  Until something other than “None” is chosen for the Channel 
Type, nothing will be drawn on the main screen.  Once these fields have been set, you can 
press the Close button in the lower right corner (see Figure 2-3).  This will return focus to 
the main SyncLights window.
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Figure 2-3: Screen to Specify a New Control Channel

If you have not already set the position and size of the channel, you can edit it on the 
main screen.  The selected channel will have green resize bars in the corners (see Figure 
2-4).  You can select a channel by clicking on it or by manually selecting it from the drop 
down box in the lower left corner of the main screen (also shown in Figure 2-4).  Once a 
channel is selected, it can be clicked on and dragged to a new location.  To do this, click 
the left mouse button on the object somewhere in the center of the four green corner 
boxes, hold the button down while moving the mouse to a new location, and then release 
the mouse button once at the new location.  The dimensions of the channel can also be 
changed similarly with a click and drag directly on any of the green corner boxes.

Figure 2-4: New Channel
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The described procedure should be repeated to create as many control channels as 
desired.  Each can be positioned around the design area to match the intended display.

More Information: Refer to the Control Channels chapter on 
page 23.

Create a Sequence

After one or more control channels have been defined, you can create a sequence.  A 
sequence is a timed set of waveforms that are applied to the defined channels.  As an 
example, assume that 3 channels have been defined.  A simple sequence could be defined 
to initially keep all channels off, then turn on channel 1 and 2 after 1 second, next turn on 
the 3rd channel 1.5 seconds later, and then finally turn off all three channels 0.2 seconds 
later.  These events could be specified and saved as a sequence.  As you can imagine, 
much more complicated sequences are also possible. 

The Sequence Timing Editor screen is shown in Figure 2-5.  It uses waveforms to depict 
the on/off states of all defined channels.  Each defined channel has its own waveform, or 
row in Figure 2-5.  All channels are listed in rows from top to bottom with some off 
screen and accessible by scrolling down.  A sequence is a collection of channel 
waveforms that are executed at the same time and reside in the same file.  The columns in 
the Sequence Editor represent different moments in time.  Vertical time bars help to 
identify and select specific times to manipulate.  The list of control channels (rows) can 
be scrolled and the time can be adjusted by zooming in and out using the buttons at the 
bottom, the menu, or keystroke shortcuts. 

The waveforms depict the following two states using both levels and colors for clarity.  A 
change in state takes effect at the instant in time (column) where the waveform transitions 
between these two values.

• ON – A channel is on if the waveform is drawn high with a green line.
• OFF – A channel is off if the waveform is drawn low by a red line.

When first launching the Sequence Timing Editor, the channel waveforms will be blank 
and in the off state (red and low).  If a prior sequence was loaded, simulated, or executed, 
the Sequence Editor screen may show that sequence’s waveforms instead.  
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Figure 2-5: Sequence Timing Editor showing a loaded sequence

Whether waveforms from a sequence appear or not, you should select New Sequence 
from the File menu if you want to start from scratch.  This will not only clear any 
predefined waveforms, but prompt you to configure parameters associated with the new 
sequence.  After confirming that you want to start a new sequence, you will be asked to 
specify the song and control resolution.  Use the browse button to navigate to find the 
desired multimedia file.  Any file format supported by Windows Media Player is 
permitted.  The length of this file will determine the length of the sequence in seconds. 
You will also need to specify the control resolution.  The control resolution determines 
how precisely you can change the states of the control channels.  You can tradeoff 
precision (possible switching speed) for a longer sequence.

Once you have configured the sequence, you can begin editing it.  Notice the two blue 
time bars on the Sequence Editor screen.  You can click and drag on these time bars to 
define a time interval.  It may be helpful to Zoom In or Zoom Out using the View menu to 
focus on the area of interest.  Once the time interval is set, one should check the boxes 
beside the desired control channels.  Finally, you are ready to press the On Within or Off  
Within buttons at the bottom of the Sequence Timing Editor.  These options can also be 
accessed under the State menu.  Figure 2-6 depicts these features.

This is the most basic method of defining a sequence using the Sequence Editor.  There 
are many other features to help specify the waveforms associated with a sequence.  These 
include rearranging the order of the control channels (drag and drop them), quickly 
specifying a time interval and channels (draw a box overtop the waveforms), 
automatically pulsing or toggling waveforms (Special Functions under the State menu), 
and precisely coordinating events with audible queues from the associated song (Launch 
TimeStamper under the State menu).  More information on these and other advanced 
techniques can be found in the Sequence Editor chapter that starts on page 43.
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Figure 2-6: Components involved in setting a state.

Periodically as you edit a sequence, you should save your current changes.  To do this, 
select Save Sequence from the File menu.  Initially you will be prompted for a filename. 
You will later select this filename when you wish to play back a recorded sequence.

Tip: Be sure to read about the advanced Sequence Editing 
features not covered in this chapter.  Many of these 
techniques greatly simplify the development of a 
sequence.  

More Information: See the Sequence Editor chapter on page 43.

Execute or Simulate a Sequence

Normally a user does not sit down and create an entire sequence from start to finish. 
Instead, small parts of the sequence are defined, a simulation is run, and changes are 
made as necessary to achieve the desired effect.  Once complete, the next portion of the 
sequence is undertaken and the process repeats.

When you are ready to simulate a sequence (whether it is completely finished or not), you 
first need to save your changes and close the Sequence Editor.  You can do this by 
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selecting Save Sequence from the File menu and then selecting Exit from the File menu. 
This will return focus to the main design screen.

Simulation and execution is performed using the Playlist Editor.  This is invoked from 
the main design screen by selecting Playlist Manager from the Playlists menu.  The 
playlist manager will appear.  The following steps can be performed to simulate a single 
song:

1. Push the Add button within the Playlist Manager.  
2. You will be prompted to select the sequence you wish to simulate.  Navigate to 

find the sequence file you created with the Sequence Editor.  The specified 
sequence will be added to the list.

3. Select the desired sequence from the list by clicking on it if not already 
highlighted.

4. Check the Simulate button and uncheck the Control Hardware button to run a 
simulation only.

5. Press the Play Selected button to begin playing the sequence.  The Playlist 
Manager will disappear and the main design screen will begin simulating your 
sequence by illuminating the control nodes with the specified song playing.  

During simulation, each channel is colored gray if it is off or its specified color when it is 
turned on.  Figure 2-7 illustrates the Playlist Manager as discussed above.  The 
numbering in the figure corresponds to the itemized steps above.

Figure 2-7: Playlist Manager configuration for simulation.

SyncLights Player Manual Page 16 Clocking Edge Software

1

3

4

5



As you edit a sequence, you will eventually start focusing on parts of the sequence a 
minute or more into it.  Instead of simulating the entire sequence from the start, you can 
simulate the sequence from somewhere in the middle.  To do this, specify the number of 
seconds into the sequence that you want simulation to begin.  This is done by setting the 
value under the Start Within Song field (see Figure 2-7 under the Play Selected button 
highlighted by #5).  For example, to start a simulation of a sequence a minute and a half 
into the sequence, enter a value of 90 and push the Play Selected button as before.  The 
sequence will skip ahead and play from the middle.

If you want the sequence to actually control hardware, you need to check the Control  
Hardware button on the Playlist Manager.  This is shown in Figure 2-7.  Both simulation 
and hardware control can be run simultaneously, although doing so will consume a 
greater portion of your computer’s resources.

In addition to individually specifying and executing or simulating sequences, you can 
also schedule a playlist of multiple sequences.  To do this, arrange multiple sequences on 
the list and press the Run Playlist button.  Information on this and other related options 
are described in the Executing Sequences chapter in more detail starting on page 65.

More Information: See the Executing Sequences chapter on page 
65.
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CHAPTER 3

Creating a Background Image

This chapter describes how to specify and, if necessary, create a background image to 
simulate sequences over.  The background image acts as a canvas for you to create a 
display on top of.  It is not necessary, but is useful if you know where you will be setting 
up your display.  By specifying an appropriate background image that depicts the actual 
display location, you can make simulation more detailed and realistic.  It can also be 
helpful in planning your display since you can make plan placement of display elements.

Specifying a Background Image

To specify a background image, run SyncLights and select Set Background from the File 
menu.  You will be prompted to specify a JPEG image to use as the background.  Find 
the image file you wish to use on your computer and select it.  SyncLights will load the 
image and set it as the background.  The settings file is automatically updated to 
remember your setting so that same file is used the next time you run the software.

It is also possible to set a background image by right clicking on the design area and 
selecting Set Background from the pop-up menu.
 
It is highly likely that you will need to edit the image before you can use it.  Images that 
cameras create are usually higher resolution than is necessary for viewing on a screen.  At 
the very least, you will probably need to resize the image to make it fit.  The next section 
describes recommended adjustments.  You should consider making these adjustments to 
the background image file before loading it. 

Tip: The software only allows you to load JPEG files.  If 
you have an image in a different format, you can 
convert it by opening it with an image editing utility and 
saving it as a JPEG file type.  For more information, 
see the instructions on resizing images below.  

Creating a Background Image

The purpose of the background image is to give the placed channels or display elements a 
positional reference.  You will define channels in the system which will be drawn on top 
of the background image.  The background image should therefore offer a good overview 
of the setting.  You may need to take a special picture for use as the background.  The 
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photo should capture the entire setting of your display as best as possible.  The display 
need not be setup in the photo.  The software will draw the display components in the 
foreground for you later.  You also don’t want the photo to be too bright since it may 
make editing harder.  This can sometimes be achieved by taking the photo on a cloudy 
day or after the sun goes down near dusk.

It is also important that the background image is not too distracting from the foreground 
channels.  This is best achieved by darkening the image as required using editing 
software.  In general, the following steps are recommended to optimize the image.

1. Resize the image so that it fits entirely on the screen without resizing.  The 
SyncLights software will not resize your image for you since it expects this to 
happen externally.  The image produced by most cameras will require resizing to 
fit within the resolution of your screen.

2. Darken the image so that foreground elements can easily be seen.  This can be 
done by adjusting the brightness and contrast of the image.

Any editing software can be used to perform these steps.  If you do not have editing 
software or do not know how to go about doing this, the following instructions will walk 
you through the process.  It will even help you setup a simple and free yet very powerful 
image editing software utility called IrfanView.

Acquiring Image Editing Software

As mentioned, any editing software can be used.  The only requirements are that it allows 
you to resize images, is capable of adjusting brightness, and can save the output as a 
JPEG.  If you do not have imaging software, or do not know how to use it, you should 
consider downloading and installing IrfanView.  This way you can take advantage of the 
instructions below that walk you through editing an image with this tool.  

To download the Irfanview software viewer and editor, do the following:

1. Visit the software’s homepage:  http://www.irfanview.com/  If you cannot access 
the homepage, search for “IrfanView” using any search engine (e.g. google.com).

2. Select the Download menu option on the left of the link.  If the site changed, you 
may have to browse to find where the download link is.

3. You will see several download sites.  Select one of them (for example: CNet’s 
Download.com) and download the utility.  When prompted, specify that you want 
to run the executable so you can install it.

4. After the download is complete and you run the file.  You can accept the default 
fields as you walk through the installer.  You will also be prompted to specify 
whether or not you want to install the Google toolbar during the installation.  It is 
not necessary, so you can specify not to install it unless you actually want it.
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Once the installation completes, run Irfanview using the desktop icon or by navigating 
the program menu to find it.  The following steps will help you use this software to edit 
the image.

Resizing the Image

First you will need to run Irfanview and open the image.  You can select the program by 
going to Start > Programs > Irfanview.  Once you run the program, select Open from the 
File menu.  Browse to find the image file you created or want to use as the background 
image.

Irfanview has two display options.  In one mode, it will show the image as its actual size. 
This is what the SyncLights software will do.  The other mode will automatically have 
Irfanview rescale the image so it fits on your screen.  It will not change the file.  You still 
have to make changes yourself.  It only temporarily resizes it so that it fits on the screen. 
SyncLights will not do this for you currently.

Within Irfanview, go to the View menu and then Display Options.  The Fit Images to  
Window option may be checked.  This will make Irfanview rescale the image before 
displaying it.  This will make resizing confusing since any attempt to resize the image 
will not be made apparent because Irfanview will automatically rescale it so that it always 
looks to be the same size.  It is therefore important that you check the Fit Window to 
Image (1:1 recommended) option under View > Display Options.  A checkbox should 
appear next to this item once selected.

Once this setting is confirmed, you can resize the image by selecting Resize/Resample 
from the Image menu.  Make sure that you opened the image first or this option will 
appear grayed out.  A new window will appear.  Select the Best fit to desktop option and 
then press Ok.  This will resize the image so that it is approximately the size of your 
desktop.  This will suffice for most situations.  If you find that the image is still a little 
too big after loading it in SyncLights, you can manually resize it instead.

To manually resize the image, check the Set new size as percentage of original option on 
the left instead of using the Best fit to desktop option described above.  This will require 
you to enter a scaling percentage.  If you enter 50%, the image will become half the size 
it used to be.  You may have to play around to figure out what size is most appropriate. 
After you push Ok, Irfanview will resize the image and show you the new actual size. 
Once it takes up nearly all of your screen without exceeding the screen dimensions 
(which you’ll notice when parts of the image are not viewable on the screen), then you 
probably have chosen a good value.  If the percentage you picked does not seem 
appropriate, you can undo the changes (Undo from the Edit menu) and try again 
(Resize/Resample from the Image menu).

Once you have resized the image, you can save your changes by selecting Save As from 
the File menu.  When doing so, you should specify the “Save as Type” to be “JPEG – 
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JPEG Files.”  This will ensure that you create a file in a compatible format for 
SyncLights.  You may want to save your changes under a different filename so as not to 
overwrite the original image in case you want to revert back to it and try again.

Tip: Once you load the background image in SyncLights, 
you can optionally maximize or resize the design 
window to take advantage of larger images.  

Adjusting the Brightness of the Image

Irfan view can also help you adjust the image brightness.  If you do not already have the 
image open, you need to open it by selecting Open from the File menu within Irfanview.  

Select Enhance Colors from the Image menu.  A new screen will pop-up showing before 
and after images.  Adjust the “Brightness” into the negative range (to the left) to make the 
image darker.  Your goal is to still be able to make out what is in the image, but to make 
it dark enough that display elements drawn on top of the image can be easily seen.  You 
can also adjust the “Contrast” setting if you want.  When you are finished, press Ok.

If you are happy with the changes, select Save or Save As from the File menu to save the 
changes.  Specify the “Save as Type” to be “JPEG – JPEG Files.”  As mentioned 
previously, you may want to avoid overwriting the original file in case you are unhappy 
about the results and want to try again.  If decide that you do not like the changes, select 
Undo from the Edit menu and then repeat these steps to try again.

Figure 3-1 and 3-2 show an example of a picture that has been modified.  Figure 3-1 
shows the original photo taken in relatively bright light.  This image was edited using 
Irfanview to reduce the brightness.  Figure 3-2 shows the darkened image which is more 
appropriate for use as a background.  Notice how you can still make out the key features 
of the setting, but they are more subtle.  This will ensure that the defined control channels 
painted in the foreground by the software are very distinct.

Tip: If you are trying to set several different sized 
background images, the entire image may not be 
loaded each time.  To ensure that the entire image is 
loaded, you can exit and run the program again after 
selecting the desired image.  The image will be 
automatically loaded the next time you run the 
software and any adjustments will be made.  This may 
be helpful if you experience any problems. 
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Figure 3-1: Background Image Before Adjustments 

Figure 3-2: Background Image after Adjustments to Brightness
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CHAPTER 4

Control Channels

This chapter describes how to define and work with channels.  Channels represent 
individual entities in your system which you wish to control.  You need to specify 
information about each channel so that programmed sequences can be associated with it, 
simulations can depict it, and executed sequences can control it.

The channel list acts as an index for the programmed control sequence.  It is nothing 
more than a collection of individually defined channels.  When a programmed sequence 
is played, the Channel IDs associated with sequence waveforms are looked up in the 
channel list.  If a matching channel is found, the channel definition is used to determine 
how to access the channel in hardware or sketch the channel for simulation.

Creating a New Channel

A new channel can be created by selecting Create New Channel from the Channels menu 
or by pressing the New Channel button next to the channel list in the lower left corner of 
the main design screen.  This is how you to create a new channel when planning a layout 
from scratch, or add an entirely new channel to an existing set.

Upon creating a new channel, a new window will appear to allow you to specify the 
details of the channel.  This is shown in Figure 4-1.  The newly added channel will also 
be added to the list of channels shown at the bottom of the main design screen. 

SyncLights Player Manual Page 23 Clocking Edge Software



Figure 4-1: Screen to Specify a New Control Channel

After you create a new channel, you will need to specify the following information about 
it.  These fields are shown in Figure 4-1 from top to bottom.  Asterisks appear next to 
fields that should not be overlooked when creating a new node.

Channel ID: This value is automatically assigned.  The ID is used to uniquely 
distinguish between different channels when programming sequences.  You can change 
the ID that a sequence targets when loading a sequence, so there is no need to change the 
Channel ID itself.  For more information, see the section entitled Loading a Sequence 
starting on page 37.

Enabled: Only enabled nodes are controlled during simulation and execution of 
sequences.  You can disable a given node without needing to erase the waveforms in 
programmed sequences by simply disabling it.  Normally the Enabled box should be 
checked so that the channel is controlled.

* Channel Name: The channel name is the name of the channel.  This name will 
appear on the channel list in the Sequence Editor, on the channel drop down box, the 
node lists managed using the remote control software, and other locations.  It is therefore 
important to specify a meaningful name.  Try to avoid using the same name more than 
once.  Ideally the name should communicate the node’s identity without referring to its 
depiction on the main design screen.  Names like “Left Green Tree” or “Mini Snowman 
3” are good examples.  Try to avoid naming multiple nodes vaguely as “Tree” or “Candy 
Cane.”

* Channel Type: The channel type tells the software how to draw the channel on 
the main design window.  This is very important for simulation of sequences, although it 
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has no effect on hardware control and execution.  Even if you do not plan to simulate, 
specifying a channel type can be useful to help organize the control nodes on the screen 
for reference when planning sequences.  As you select one of the available options, you 
will see the new channel being drawn on the editing screen behind the channel editor 
window.  If you specify “None” as the channel type, there will be no image drawn to 
represent the channel.

HW Comm Line: The hardware communication line refers to the SPI channel 
used to access this channel in hardware.  Please refer to the Hardware Interfaces chapter 
starting on page 59 for more information about specifics.  You may see a different name 
for this field depending upon the hardware interface you have chosen.  If you have not 
solidified hardware plans yet, you can leave this field at its default and change it later.

HW Bit: The hardware control bit refers to the individual bit used to access the 
channel via the specified hardware communication line.  Please refer to the Hardware
Interfaces chapter starting on page 59 for more information about specifics.  You may see 
a different name for this field depending upon the hardware interface you have chosen.  If 
you have not solidified hardware plans yet, you can leave this field at its default and 
change it later.

Color: The selected channel will be drawn using this color when the channel is 
on.  When a channel is off, it is colored gray.  It is therefore important not to specify gray 
as the color or you will not be able to distinguish between the on and off states during 
simulation of sequences.

Height: The height represents how tall the channel will appear on the main design 
screen.  The channel will update automatically in the background window as this value is 
changed.  You can use the scrollbars to specify an exact number of pixels or manually 
resize the channel from the main design screen.  Details on resizing directly from the 
design screen are covered in the next section.

Width: Like the height, the width specifies how wide to make the channel when 
drawn on the main design screen.   It can also be specified exactly in pixels or manually 
resized later from the main design screen.

Location Y:  The channel can be positioned on the main design screen by 
specifying an X and Y coordinate.  The Y coordinate represents the vertical position of 
the upper left corner of the channel.  You can precisely specify values or manually 
position the channels by dragging and dropping them within the main design screen later. 
More information on this is described in the next section.

Location X: The X coordinate represents the horizontal position of the upper left 
corner of the channel.  It behaves exactly as the Y location field described above.

Channel Notes: You can enter any arbitrary notes that you want to associate with 
the channel.  This can be useful to record information about a specific channel like the 
current requirements, distance away for connecting power, known defects, etc.  These 
notes are included on the hookup list you can choose to generate under the Channels 
menu.

Line Width: Many channels are composed of several lines.  You can specify the 
individual thickness of the lines.  The image will update automatically in the background 
on the design screen as this value is changed.  When depicting small objects, thinner line 
widths may be helpful.
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Characters: If you specify a node type of “Text”, you will see a “Character” field 
in place of the “Line Width” field.  You can enter a text string that you wish to show up 
on the design screen.  The font size can be controlled by scaling the desired width of the 
channel.

Current: You can optionally record the current required to power the channel in 
Amps.  This is only used to calculate the overall power utilization and cost.  If you know 
the power dissipation of the device in Watts, you can divide by the line voltage (120VAC 
in the U.S.) to determine current.  For example a 100-Watt device consumes 0.83 Amps 
(100 W / 120 V = 0.83 A).

Table 4-1 compares the impact of each of the values.  Values can always be updated later. 
At the very least, it is recommended to specify the “Channel Name” and “Channel Type” 
so that the node can be easily visualized and referenced for later specification.

Field
Identifies
Channel

Design Screen Visual
Depiction and Simulation

Used for Hardware
Execution & Control

Channel ID Yes Yes Yes
Enabled - Yes Yes
Channel Name Yes - -
Channel Type - Yes -
HW Comm 
Line

- - Yes

HW Bit - - Yes
Color - Yes -
Height - Yes -
Width - Yes -
Location Y - Yes -
Location X - Yes -
Channel Notes - - -
Line Width - Yes -
Characters - Yes -
Current - - -

Table 4-1: Fields related to each individual channel.
 

More Information: See the Hardware Interfaces chapter starting 
on page 59.
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Editing an Existing Channel

To edit the complete details pertaining to a channel, select the desired channel and press 
the Edit Channel button in the lower left corner of the main design screen.  The desired 
channel can be selected by choosing it from the adjacent drop down box in the lower 
corner, or by clicking on the visualization of the channel on the main design screen.  If 
multiple channels visually overlap one another, continue to click slowly upon them to 
sequence through each possible channel.  Once the Edit Channel button is pressed, the 
screen shown in Figure 4-1 will appear.  The individual fields can be specified as outlined 
previously in the Creating a New Channel section starting on page 23.

A channel can be resized within the main design window.  To do so, click on the desired 
channel.  Four green boxes will highlight the corners of the selected channel.  To resize 
the channel, click on one of the green boxes, hold down the mouse button, and drag the 
box to a new desired position before releasing the mouse button.  Refer back to Figure 2-
4 for more 

Figure 4-2: Moving and Resizing Channels

A channel can also be edited by right clicking on it once it has been selected.  The Edit  
Channel option can be selected from the pop-up menu to bring up the channel editing 
window.  Figure 4-3 shows the pop-up menu options.

Tip: When moving or resizing channels by clicking on 
them, make sure you select the channel before you 
attempt to modify it.  You cannot move or change a 
channel until it has been selected.  The green corner 
boxes appear to indicate selection of the channel and 
the name of the channel appears in the lower left drop 
down box.  

Tip: If you cannot find the channel you wish to edit on the 
interface, select it from the lower left drop down box 
and use the Edit button to allow you to manually 
reposition it to a known location.  
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Deleting a Channel

The easiest way to delete a channel is to first select it from within the design window by 
clicking on it.  Once the channel is selected, it can be right clicked on to bring up the pop-
up menu.  The Delete Channel option can be selected to eliminate the chosen channel. 
Figure 4-3 shows this option selected.

You may want to delete a channel if you want to eliminate it from your display.  Once 
deleted, sequences that reference that channel will no longer apply.  When you load a 
sequence in the Sequence Editor that references a deleted channel, you will be prompted 
to resolve the missing channel.  You can allow the waveform associated with that channel 
to simply be deleted or you can associate it to another channel.  For more information 
about this process, see the Loading a Sequence section on page 37.

Figure 4-3: Context menu from right clicking on a channel

Deleting All Defined Channels

If you want to delete all defined channels and start from scratch, you can do so by 
selecting Edit Channel List from the Channels menu.  A new window will appear which 
was previously shown in Figure 2-2.  To delete all channels, simply select all channels on 
the Current Channels list and then press the Delete Selected button.  All channels will be 
eliminated.  The Use New Channels button can be pushed to make the changes take effect 
and return to the main design screen.

Saving a Channel List
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After one or more channels have been created or an existing channel list has been 
modified, you can save the list to a file.  To do so, select Save Channel List from the 
Channels menu.  You will be prompted to specify a filename to save under.  You can 
specify the loaded file and overwrite it if you do not need the channel list prior to the 
changes.

Opening a Channel List

When you run SyncLights, the previously displayed channel list is automatically loaded. 
You can select another channel list by opening another channel list file.  To do so, select 
Load Channel List from the Channels menu.  You will be prompted to select the desired 
file containing the channel list definition.

If you wish to selectively load channels from a saved channels list, you can.  This 
involves selection of the Edit Channel List option from the Channels menu.  This is 
described in more detail in the next section titled Importing Channels from a Saved
Channel List.

Tip: You can also load a channel list by right clicking on 
the background of the design screen and selecting the 
Load Channel List option. 

Importing Channels from a Saved Channel List

Instead of loading an entire channel list, you can selectively import channels from a 
channel list file.  To do this, select Edit Channel List from the Channels menu.  The 
window shown in Figure 4-4 will appear.

The “Current Channels” are shown on the left list of Figure 4-4.  These reflect the list of 
channels that have been defined or selected.  When you press Use New Channels, 
whatever channels appear on this list will copied over to the main design screen.   The 
“Channels from File” list reflect a list of channels available in the specified file.  These 
channels can be copied from the file to the “Current Channel” list for use.
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Figure 4-4: Manually loading channel lists

The Replace All button deletes all channels on the “Current Channels” list and replaces 
them with all channels on the “Channels from File” list.  Loading a file by pressing the 
Load from File button and then the Replace All button is the same as simply loading a 
channel list file from the main screen.

To add additional channels from a file to the current set of defined channels, first press 
the Load from File button.  You will be prompted to specify a file.  All channels defined 
in the file will be loaded into the “Channels from File” list.  These can be selected by 
clicking on them.  When the Copy button is pushed, the highlighted channels from the 
file will be copied to the “Current Channel” list.  New Channel IDs will be automatically 
assigned if there is a conflict with a previously defined channel.  Channel IDs appear in 
brackets after the channel name.

Channels can also be deleted from the current channel list.  This was described in a prior 
section.  The channels to delete are selected from the “Current Channels” list and then the 
Delete Selected button can be pushed.

Tip: Be careful not to Copy channels from the file that are 
already defined in your Current Channels list.  If you 
do, duplicate channels will be created.  The redundant 
channels will be allocated a new unique Channel ID so 
it can be uniquely handled.  This is a great way to 
copy channels as the next section describes. 
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Copying Channels

The easiest way to copy an existing channel is to select it on the main design screen. 
This is done by clicking on it.  You can then right click on the channel and select 
“Duplicate Channel” to create a duplicate channel.  The channel editor will appear to give 
you an opportunity to give the channel a new name.

If you wish to replicate many defined channels, you can also take the following steps:

1. Create the channels you wish to copy and save them to a channel list file if not 
already done.

2. Select Edit Channel List from the Channels menu of the main design window. 
The window shown in Figure 4-4 will appear.

3. Push the Load from File button and select the file that contains the channels you 
wish to copy.  This is the file you created in step 1.  The channels from the file 
will be loaded into the “Channels from File” list.

4. Select one or more channels from the “Channels from File” list that you wish to 
replicate.

5. Press the Copy button to copy the selected channels to the “Current Channel” list.
6. Repeat step 5 by pressing the Copy button again to create as many copies of the 

channel or channels as desired.  A unique channel ID will be automatically 
created for the new channel if it conflicts with an existing channel.

7. Once adequate copies have been made, press the Use New Channels button to 
return to the main design screen.

8. The duplicated channels will overlap the existing nodes visually on the design 
screen.  Click on each duplicate channel or select it from the lower left channel 
listbox.  Once selected, press Edit Node to edit the redundant channel.  

9. Specify a new channel name and modify the channel’s position so that it is 
visually distinguishable on the main design screen.

10. Repeat steps 8 and 9 to edit other duplicated channels.

Tip: If two elements of your display share the same 
location, it may be tempting to position the channels 
directly on top of each other on the main design 
screen.  Both channels will not be visible during 
simulation though.  Instead, slightly offset one of the 
channels by a small amount in the X and/or Y direction 
so that both channels can be seen while still residing 
in close proximity. 
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Hookup List

You can generate a “Hookup List” or a Connection List to describe how to connect your 
channels to the system hardware.  To do this, select Generate Hookup List from the 
Channels menu.

You will be asked to specify where you want to create the comma separated value file. 
You will also be asked if you want to enumerate all possible channels.  For example, you 
may not make assignments to all possible hardware connections.  If you enumerate 
everything, it will show blank entries for the unconnected hardware too.  Otherwise only 
hardware with actual channels assigned to it will be included.

Hardware Tester 

Normally devices are turned on or off in hardware through their channel name aliases. 
The SyncLights software is used to create a channel list and each channel is mapped to a 
hardware control ID.  To turn on or off a device, the channel must be setup, selected, and 
set.

The Hardware Tester bypasses the channel aliasing to allow simple testing of hardware. 
It can be brought up by selecting Hardware Tester from the Hardware menu.  The 
specifics of the interface will vary depending upon the configured hardware interface.  It 
essentially allows direct control of individual hardware devices by manually specifying 
the hardware ID information necessary to turn them on or off.  It is a great tool for 
preliminary testing of hardware well before the channels, channel lists, or sequences have 
even been defined. 

The All On and All Off options enable or disable all possible control bits in the system. 
The Turn On Selected Only button only enables a single channel and automatically 
advances to the next bit so that pushing it again will test it next.

A Special Note About Channel IDs

A channel ID is an identifier that is used to link a given channel to a specific waveform in 
a programmed sequence.  It is therefore important that each channel has a unique ID. 
The SyncLights software preserves this requirement automatically.

Throughout the software, channels are often referred to using the following format:

Format: Channel Name [Channel ID]
Example: Candy Cane 2 [31]
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In the example above, the channel’s name is “Candy Cane 2” and the unique channel ID 
associated with it is 31.  It is recommended that each channel be given a unique name for 
clarity.  This is recommended for convenience and is not strictly required since the 
channel ID uniquely distinguishes between identically named channels.  You can always 
check the equivalence of channels throughout the software by checking the channel ID 
shown in brackets.

While sequences reference channel IDs, this relationship can be remapped.  This permits 
channel lists to be changed without compromising defined sequences.  If the channel ID 
changes, you will be prompted to resolve the discrepancy when loading the affected 
sequence in the Sequence Editor.  More information about remapping of channel IDs is 
covered in the Loading a Sequence section starting on page 37. 
 

More Information: See the Loading a Sequence section starting 
on page 37.
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CHAPTER 5

Programmed Sequences

This chapter covers the basics regarding programmed sequence files.  A channel  
waveform is a collection of states that are applied to defined channels at specific times.  It 
appears as a single row in the editor.  The programmed sequence file contains a set of 
channel waveforms and other information.  Sequences are defined using a waveform 
editor within the software.  Each sequence file is associated with a song for playback 
purposes.

Creating a New Sequence

Before you can create a new sequence file, you must first launch the Sequence Editor.  To 
do so, select Edit Sequences from the Sequences menu of the main design screen.  This 
will launch the Sequence Editor shown in Figure 5-1.

Figure 5-1: Sequence Timing Editor window

The sequence editor is organized with rows of channels on the y-axis and units of time 
across the x-axis as equally spaced columns.  A given channel is turned on if it is drawn 
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high and colored green and off when drawn low and colored red.  All channels are off 
(red and low) in Figure 5-1.

To create a new sequence file, take the following steps:

1. Select New Sequence from the File menu of the sequence editor window. 
2. Confirm that you want to create a new sequence file and clear the existing 

waveforms.
3. A new window will appear to prompt for a multimedia file (see Figure 5-2).  First 

select a multimedia file to associate with the sequence by pushing the Browse 
button.  This file will be played when the sequence is simulated or executed.  It is 
also important as it determines the length of the sequence.  Once you specify a 
song, SyncLights Player will load the song in the background to determine its 
length.  The length will be displayed using the format mm:ss.ff where mm are 
minutes, ss are seconds, and ff are fractions of a second.

4. You next need to select the desired resolution for the new sequence.  This controls 
how quickly you can change the state of the controllers.  More transitions per 
second require more processing power and may limit the length of the possible 
sequence (see Table 5-1).  If you have already selected the song, resolutions that 
cannot accommodate the entire song will be grayed out so that you cannot select 
them.  Not all hardware interfaces may be capable of running at the highest 
resolution levels.  You can change the resolution later, but only by factors of two. 
Therefore you need to commit to use the green set of resolution choices or the red 
set of choices (see Figure 5-2).  

5. Push Ok when finished specifying the song and desired resolution.  This can be 
changed later by selecting Set Song from the File menu or Change Resolution 
from the Edit menu of the sequence editor screen. 

6. Select Save Sequence from the File menu to save the new sequence before you 
begin editing it.

Figure 5-2: Prompt for selecting the sequence song and resolution. 
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Transition
Rate

Time
Resolution

Maximum Sequence
Length

4 per second 250 milliseconds 34 minutes 8 seconds
8 per second 125 milliseconds 17 minutes 4 seconds
16 per second 62.5 milliseconds 8 minutes 32 seconds
32 per second 31.3 milliseconds 4 minutes 16 seconds
5 per second 200 milliseconds 27 minutes 18.4 seconds
10 per second 100 milliseconds 13 minutes 39.2 seconds
20 per second 50 milliseconds 6 minutes 49.6 seconds
40 per second 25 milliseconds 3 minutes 24.8 seconds

 
Table 5-1: Since each sequence is limited to 8192 points, the transition 
rate may limit the maximum length of the sequence.  Longer sequences 
can be created by breaking it into separate sequence files.  If the chosen 

song is shorter than the maximum length, it will dictate the sequence 
length.

Even if you do not care to associate a song with the sequence, you will still have to 
specify a multimedia file.  Any file can be chosen.  The important criteria will be to select 
a multimedia file that is about as long as you want the sequence to last.  This is necessary 
since the sequence length is automatically set to the length of the multimedia file in 
seconds.

If your application does not require a multimedia file, you can voice your needs to the 
developer for consideration.  Future versions may avoid the need to associate each 
sequence with a song.  See the chapter titled Additional Feature Requests beginning on 
page 84 for more information.
 

Note about Higher Resolutions:

Higher resolution settings (more transitions per second) require more computational 
resources.  If the computer cannot keep up, SyncLights Player will automatically adjust 
on the fly to keep pace with the song.  This may result in periodically skipping 
transmission of patterns to hardware in extreme cases.  The channel states will be updated 
at the next time stamp though so that everything will get back on track.  To avoid the 
likelihood of this becoming an issue, you should try not to enable both simulation and 
hardware control simultaneously for rates above 20 transitions per second.  This is 
especially true when running on an older computer.  It is also recommended to disable 
other tasks and programs on the computer controlling the hardware.
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If you select Show Debug Stats from the Hardware menu, you can view the number of 
skipped patterns live as a sequence executes.  It is shown under the “Skipped Index 
Count” title.  If this count is more than 2-3 percent of the total indexes processed (“Last 
Processed Index”), then you may be running too fast for the hardware interface or 
computer.  Try closing other running applications or processes, disabling simulation or 
hardware control unless both are needed, and modifying the hardware interface settings if 
applicable.  Displaying the debug statistics also consumes a slight amount of additional 
resources, so it is also recommended that you keep it closed when not in use. 

The software has an allowance for timing jitter built into it.  This permits patterns to be 
shifted out slightly before or after the ideal target time.  This helps avoid the likelihood of 
the time being missed due to other processor events.  In general, the allowable jitter is no 
more than plus or minus 25 milliseconds or 30% of the time interval specified by the 
resolution (the inverse of the number of assertions per second), whichever is smaller.

More Information: See the Debugging Execution section starting 
on page 68.

Saving a Sequence

To save a sequence file, select Save Sequence from the File menu of the Sequence 
Timing Editor.  This will save the file under the previously specified name.  If you want 
to save the file to a new location, select Save Sequence As instead.

Tip: To protect the time you invest into developing a 
sequence, it may be a good idea to save separate 
versions of the file to protect your data in case you 
make changes that you do not like.  You can 
automatically do this by selecting Create Backup from 
the File menu of the Sequence Editor.  A prompt will 
inform you of the backup filename that was created. 
Normal saving (File > Save) is still necessary and will 
be directed to the active filename you are working on. 
As with any program, save early and often!

Loading a Sequence

Once you have saved a sequence file, you can load it by selecting Open Sequence from 
the File menu.  Navigate to select the desired sequence file.  The new sequence will be 
opened and focus will return to the Sequence Editor provided that all channel IDs in the 
sequence are defined.  If they are not, a series of prompts will appear to allow you to 
reconcile the discrepancy.
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If one or more channel IDs in the sequence file is not loaded in the currently active 
channel list, a prompt similar to that shown in Figure 5-3 will appear.  This will most 
frequently occur when loading a sequence file from someone else’s display or from a 
different display than the one you are currently working with.  It can also occur if you 
forget to load the control channels before attempting to edit a sequence.  If you 
accidentally failed to load the control channels list, you should press ‘No’ and return to 
the main design screen to load the control channels.  Make sure you DO NOT save the 
changes to the sequence file in this case or you risk overwriting the defined sequence 
with empty channel waveforms.  The software will similarly warn you about this.

Figure 5-3: Prompt for Unmapped Channels in a Loaded Sequence.  
The general recommended response is Yes as detailed below.

The prompt shown in Figure 5-3 explains the situation and asks the user to make a 
decision.  One option is to simply discard the channel waveforms tied to undefined 
channels and load the rest of the sequence file without them.  Pressing ”No” will do this. 
Focus will simply return to the Sequence Editor and no additional action will be required. 
The unmapped channel waveforms are simply discarded and only those that map to 
currently defined channels are actually loaded.

Warning:  If you choose to discard unmapped channel 
waveforms, you may want to save the 
sequence under a different filename.  If you 
overwrite the original file, the discarded 
waveforms will be lost permanently.

Normally, you will want to push “Yes” to resolve the unmapped channels.  This is a 
recommended action even if you believe that you eventually want to discard the 
unmapped channel waveforms.  Pressing “Yes” will give you an opportunity to view the 
former channel names that had been associated with the now unmapped waveforms and 
confirm that they are not needed.  A new window will appear to help settle the 
discrepancy.  This is shown in Figure 5-4.  
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Figure 5-4: Screen Used to Resolve Unmapped Channel
Waveforms Defined in a Loaded Sequence

The window shown in Figure 5-4 is made up of 3 different lists:

• Upper Left List: This list itemizes channels in the system which are defined but 
not referenced in the loaded sequence file.  If this list is empty, it simply means 
that every channel that your system has defined also has a defined waveform in 
the sequence you are loading.  In other words, channels on this list represent 
nodes that were not mentioned in the loaded sequence.  These channels do not 
pose a problem and are not the reason this prompt appeared.

• Upper Right List: This list itemizes the unmapped channel waveforms that are 
problematic.  The list describes channels that have waveforms defined for them in 
the loaded sequence file, but are no longer defined.  The channel names shown 
reflect the names of the last known channel used associated with the waveform. 
All channel waveforms that remain on this list when the Finished button is pushed 
will be discarded.

• Lower List: When loading the sequence, the software tries to map all defined 
channel IDs in the file to matching channel IDs already loaded in the software. 
Initially this list displays the default mapping produced by simply matching 
channel IDs.  As additional mappings are specified, these will be taken from the 
lists above and added to the lower list.

Mapping an Undefined Waveform to a Different Channel 

To map an undefined channel waveform (upper right list) to a defined channel (upper left 
list), you simply select the corresponding item from each list and press the Map Channels 
Selected Above button.  This will remove the two selected items from the upper lists and 
move them to the lower list.  
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For example, assume that last year you had a display that had seven trees.  You created a 
sequence that was associated with this setup.  This year you eliminated one of the trees. 
We will call the eliminated tree “Tree 7.”  You also added a few new channels this year. 
One of these channels is a snowman.  When working with the new display, the first time 
you load the old sequence file, the software will not be able to find “Tree 7” since you 
removed it.  Assume that last year you had Tree 7 blink on and off every 1 second.  The 
waveform associated with this pattern still resides in the sequence file.  When you open 
it, SyncLights does not know what to do with it though.  After all, there is not a Tree 7 
anymore to associate it with.  Under this circumstance, you will be asked to resolve the 
unmapped channels (Figure 5-4).

If you don’t care about the channel waveform formerly associated with “Tree 7,” you can 
simply discard it.  If you do, you can apply this waveform pattern to a different channel. 
Assume that you want to make the “Snowman” channel blink every 1 second this year 
just like “Tree 7” did last year in this programmed sequence.  This can be accomplished 
by doing the following (refer to Figure 5-5): 

1. Select the channel “Snowman” from the upper left list.
2. Select the unmapped channel waveform for “Tree 7” from the upper right list.  
3. Press the Map Channels Selected Above button.
4. The two selected channels will be removed from the upper lists and placed on the 

lower list of mapped sequences.

Figure 5-5: Example that Maps an Undefined Waveform to a Defined Channel 

By mapping these selected channels, you are basically saying that you want whatever 
waveform that used to apply to “Tree 7” (which is not defined in your system – at least 
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not using the same channel ID) to be applied to “Snowman.”  Figure 5-5 illustrates this 
example and how it would be added to the lower mapped list.

In the prior example, it was assumed that an available channel was on the upper left list to 
associate the sequence with.  This may not be the case though.  You can alternatively 
create additional channels as needed on-the-fly by specifying the “New Name” for the 
channel in the upper left corner and then pressing the Create New button.  In doing so, 
you create additional channels to associate your unmapped waveforms with.  You will 
still need to make selections from this list and press the Map Channels Selected Above 
button.  Once the remapping is complete, you can return to the main design window to 
edit any newly created channels.

When all associations have been mapped, you can press Finished to return to the 
Sequence Editor screen.  In doing so, all channel waveforms listed in the upper right list 
will be discarded.  These waveforms will be permanently lost if you overwrite the 
changes to your current sequence file.  To avoid this, give the sequence file a new name.

Changing Defined or Default Mappings 

If you create a mapping that you do not want to keep or want to make changes to the 
default mappings, you can do so by selecting it from the lower list and pressing Unmap 
Selected Channels.  This will cause the individual defined channel and unmapped 
channel waveform to return to the upper left and upper right lists respectively.

The software builds this mapping by matching channel IDs.  If this default technique 
does not yield the desired result, you can unmap and remap it manually as described.
 

Manually Remapping Channel Waveforms

As previously described, remapping of channels and channel waveforms can be 
necessary.  This occurs when channel IDs present in the sequence file are not found in 
your loaded channel list.  You may also want to remap channels and waveforms even 
when it is not strictly necessary (even when all IDs match up).  This may occur if you 
simply want to rearrange which waveforms are applied to which channels.  You could 
use the waveform editor on the Sequence Timing Editor screen to manually copy and 
paste the waveforms.  It is also possible to swap the waveforms around as you load the 
file.  This latter approach is faster.

To do so, select Open and Remap Sequence from the File menu of the Sequence Editor 
screen.  After confirming your intentions, you will be taken to the remapping screen 
shown in Figure 5-4.  You can press the Unmap Selected Channels to break the default 
associations between channels and sequence file waveforms.  This will give you an 
opportunity to remap them as described in the previous sections. 
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More Information: See the Sequence Editor section starting on 
page 43 for information about how sequences 
are defined.
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CHAPTER 6

Sequence Editor

This chapter describes the interface used to edit sequences.  The sequence editor is the 
waveform editor within the software that facilitates the manipulation of sequences.  For 
general information on sequences, please refer to the prior chapters.

Editing a Sequence

At a minimum, there are three things you need to understand about editing sequences:

1. How to move the time bars to define an interval where you wish to turn on or off 
selected channels.

2. How to scroll through the defined channels and check those to apply specified 
changes to between the time bars.

3. How to zoom in and zoom out to view portions of the sequences in more detail.

Time Bars

Figure 6-1 shows the two timebars.  Any changes made will be applied to the selected 
channels from 1 minute 17.3 seconds into the sequence until 1 minute and 20.7 seconds. 
The times use the format mm:ss.ff where mm is in minutes, ss is in seconds, and ff is 
in fractions of a second.

Figure 6-1: Sequence Editor Time Bars

To move a timebar, simply click on the blue vertical line that represents it and drag it to a 
new location.  This involves clicking on the blue line with the left mouse button, holding 
down the button as the mouse is positioned at a new location, and then releasing the 
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mouse button at the new location.  When moving timebars, the mouse should be moved 
horizontally.  If it is moved both horizontally and vertically, the software will assume that 
you are trying to draw a box to encompass multiple channels and the time interval 
defined by the boundaries of the box.  You will see the cursor change from the left-right 
(timebar moving) arrows to a cross (drawing a box) when this happens.

Tip: Sometimes both waveforms may be positioned at the 
exact same location.  When this happens, you will only 
see one blue vertical line with two times at the top. 
You can separate them by trying to reposition the 
single line (click and drag it with the mouse).

You can also reposition the time bars by right clicking on the new desired location and 
selecting Place Left Cursor Here for the left timebar or Place Right Cursor Here for the 
right timebar.

Tip: If you switch windows to look at the main design 
screen (leaving the timing editor open), you can 
visually see which channels are currently on. 
Channels that are on will be colored and channels that 
are off will be grayed.  This reflects the configured 
states at the time location where the left time bar is 
positioned.  

Selecting Channels

On the left of the Sequence Editor screen is a list of defined channels.  Each separate 
channel has a checkbox next to it.  If you check the box associated with the channel, any 
change you specify will be applied to those channels between the timebars.  Only 
channels whose waveforms are visible can be checked and affected by changes.  Those 
off screen are unchanged (even if they were checked before scrolling to other channels 
made them invisible).

Only a finite number of channels are shown on the screen at once.  Additional channels 
are depicted off screen.  You can navigate to view those channels by using the vertical 
scroll bar on the right side of the window.  This can also be accomplished by scrolling the 
center wheel on a wheel mouse.

An example of how this works is shown in Figure 6-2.  Assume that initially all channels 
are off.  To turn on some channels for 1 second between the 1.00 second and 2.00 second 
of execution, position the timebars at these moments.  Next select the three channels by 
checking their checkboxes (see left column of Figure).  If the lower green On Within 
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button is pushed or On Within is selected from the State menu, the waveforms will 
change to look like that shown in Figure 6-2.

Figure 6-2: Example Turning on Three Channels for 1 Second

Tip: If you wish to select several sequential channels, you 
can draw a box over the waveform area that outlines 
the area you wish to affect.  Click the mouse button at 
one corner, hold it down and drag it to the opposite 
corner of the box.  When you release, the time bars 
will be positioned at the sides of the drawn box and 
the channels between the top and bottom of the 
invisible box will be automatically checked.

Adjusting the Zoom of the Waveforms

There are four zoom options.  All four are accessible under the View menu.  The lower 
toolbar also provides a convenient method to access 3 out of the 4 zoom choices.  Figure 
6-3 shows this toolbar.

Zoom Out Completely: This option zooms all the way out so that the beginning 
of the sequence is shown on the extreme left and the very end of the sequence is on the 
extreme right.  The entire sequence can be seen from this perspective, but fine details 
may be difficult to discern for long sequences.

Zoom To Fit: This option adjusts the zoom to zoom in on the region between the 
timebars.  It zooms to show only the interval between the left and right timebars prior to 
selecting this option.

Zoom In: The waveforms are adjusted to show finer detail with a smaller time 
interval by zooming in on the waveforms.  The zoom centers in on the middle time of the 
previously displayed interval.

Zoom Out: The waveforms are adjusted to show more time.  Additional time is 
shown on both the left and right of the previous interval.

SyncLights Player Manual Page 45 Clocking Edge Software



Figure 6-3 shows the toolbars that can also be used to adjust the zoom.  From left to right, 
the magnifying glass with the plus sign corresponds to Zoom In, the magnifying glass 
with the negative sign corresponds to Zoom Out, and the magnifying glass with the arrow 
corresponds to Zoom To Fit.

You can also adjust the waveform height to squeeze more channel waveforms onto the 
screen at once.  You can select single or double height mode.  In single height mode, only 
one line is allocated for each channel waveform.  In double height mode, two lines are 
used.  Having more channels visible is convenient, but can make scrolling them slower, 
less of the channel name visible, and the on/off states less distinct.  Select Waveform 
Height from the View menu and then choose Single or Double line spacing mode. 

Figure 6-3: Lower Sequence Timing Toolbars

Tip: When you are zoomed in, you can adjust the viewable 
window of the sequence by using the horizontal scroll 
bar below the waveforms to move left and right.

Specifying Waveform States

Once the timebars are positioned to define the applicable interval to affect and the desired 
channels’ checkboxes are checked, an action can be taken to change the waveforms.  The 
simplest change is to turn on or turn off the waveform.  This is done by selecting On 
Within or Off Within.  Figure 6-3 shows the “On/Off State” toolbar with these options. 
These are also accessible from the State menu.

Visually, waveforms are depicted as either on or off using the following notation:

• ON – A channel is on if the waveform is drawn high with a green line.
• OFF – A channel is off if the waveform is drawn low by a red line.

The On/Off to Chg and On/Off to End options only involve the left timebar.  When “On 
to Change” is selected, the specified channels are turned on starting at the left timebar 
and continuing forward until the next transition is encountered.  A transition is simply a 
point where the waveform changes state between on and off.  For example, if a waveform 
is off from 0 to 10 seconds and then turns on at 10 seconds, positioning the left timebar at 
5 seconds and pushing On to Chg will turn on the channel from 5 to 10 seconds.  No 
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changes will be made past this point (it will be left on at 10 seconds onward).  The “Off 
to Change” option works the same way except that it turns the channel off until the next 
transition.

The On to End and Off to End buttons turn on or off the selected channel(s) from the left 
time bar position all the way to the end of the sequence.  This option should be used 
carefully since it can easily overwrite large segments of waveform(s).

Tip: When you select channels and change their state, all 
channel checkboxes involved in the change are 
automatically unchecked.  You can hold down the 
CTRL key while selecting On Within or Off Within to 
make the change and leave the selected channels 
checked.

Tip: These are the simplest ways to modify waveforms. 
Additional techniques can also be applied to achieve 
more advanced effects.  The next sections cover these 
features in more detail.

Copying and Pasting Waveforms

You can also copy and paste waveforms.  This is convenient to quickly replicate 
established patterns.  The waveforms associated with individual or multiple channels can 
be copied and pasted at once.

To copy a set of waveforms, first position the timebars.  Any waveform between the two 
timebars will be copied.  You should then check the boxes of the channels you wish to 
copy.  These channels do not need to be consecutive as Figure 6-4 shows (notice that the 
third waveform from the top was not included in the copy and is not blue). You cannot 
copy waveforms that are off the screen.  You can consider maximizing the screen or 
changing the waveform height to allow more channels to be viewed at once if necessary.

Once you have specified the set of channels and the time interval to copy, simply select 
Copy from the Edit menu.  The waveforms will turn blue to indicate that the pattern is 
currently available to be pasted.  Figure 6-4 shows the result immediately after selecting 
the copy option.

After copying the waveforms, you can paste them into a new location.  Position the left 
timebar at the starting location where you want the paste to occur.  The location of the 
right timebar does not matter.  Check the channels you wish to paste the waveforms over 
top.  If needed, you can rearrange the channels so control which pattern is applied to 
which channel.  You must select the same number of channels that were selected during 

SyncLights Player Manual Page 47 Clocking Edge Software



the copy.  These do not need to be the same channels though, only the number of 
channels selected must be the same.  The pattern copied from the first (or top-most) 
channel as ordered from top to bottom during the copy operation will be pasted over the 
first selected channel from top to bottom during the paste.  This permits the paste to 
easily be applied to different channels as long as they are sequenced to take effect

As long as the paste operation does not overwrite any portion of the copied waveform, 
you will be able to paste it again.  Once you modify the copied content, the copy will be 
lost and you must copy the waveforms again if additional pasting is required.

Figure 6-4: Copied waveform patterns appear blue.

Tip: The copy and paste operation is only supported from 
within the actively open sequence file.  To copy and 
paste between different sequence files, use the export 
and import feature.

Exporting and Importing Channel Waveforms

You can export sequence waveforms to a file.  The on and off states are written to the file 
for all selected channels.  Once you export channel waveforms, you can import them to 
have them applied to other channels and/or other time positions.  This feature is used 
exactly like the copy (export) and paste (import) feature.

Before exporting waveforms, you first need to specify which you want to export.  Within 
the sequence editor, check the boxes next to each channel whose waveform you would 
like to export.  You also need to set the timebars to the desired interval.  Only states 
within the specified time interval (between the timebars) of selected channels will be 
exported.
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Once the channels and timebars have been selected and adjusted, select Export  
Waveforms from the Edit menu.  You will be prompted to specify a file to export the data 
to.  By default, a comma separated value file (*.csv) will be created.  If another file type 
is specified (e.g. a *.txt or other file extension), tabs will be used to separate states 
instead.

The exported data file puts each channel’s waveform on its own line within the file.  The 
channels are allocated lines in the file based upon their top to bottom ordering within the 
Sequence Editor.  Unchecked channels are not allocated lines in the file and are not 
exported.  Each sequential state for a given channel is listed sequentially with commas or 
tabs separating each value.  The first value (0=off, 1=on) on a line corresponds to the 
value at the time position of the left time bar.  The next value on each line corresponds to 
the state at the second time interval.  This pattern continues so that the last state on each 
line represents the state at the final time interval corresponding to the right timebar.  

After exporting waveforms to a file, you can import them to the same or a different 
sequence file.  Before selecting the Import option, you should select the channels you 
wish to have the data applied to.  Check the boxes next to each desired channel.  The first 
selected channel (from top to bottom) will receive the first pattern (row or line) in the 
file.  Sequentially selected channels will similarly receive data from correspondingly 
ordered lines in the file: the first line to the first channel, second line to second channel, 
third to third, etc.  

You also need to specify the location where you wish the imported data to begin. 
Position the left timebar to specify the start location.  The stop location will be based 
upon the length of the data in the imported file.  The right timebar has no impact.

Once you have specified the channels and start position to import the data, select Import  
Waveforms from the Edit menu.  You will be prompted to select the file containing the 
desired data.  

Unlike copying and pasting, the number of waveforms selected during the import 
operation need not match the number of channels selected during the export.  If there are 
more channels in the file, only the first applicable number will be imported.  If more 
channels are selected than the file contains, the extra channels will remain unaffected by 
the import operation.

Note: Each exported point represents one time interval 
regardless of resolution.  When importing and 
exporting between sequence files with different 
resolutions, the imported data will not preserve 
actual time delays but instead will be copied point for 
point.
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More Information: See the Copying and Pasting Waveforms 
section starting on page 47.

 

Rearranging Channel Waveforms

By default, the channels are displayed in a somewhat arbitrary order in the Sequence 
Timing Editor.  This is based upon the order of creation.  For a given sequence file, the 
order can be customized though.  This is extremely useful when planning a sequence.  It 
can be useful to set the channel order to reflect actual display layout or to achieve desired 
effects with the special function patterns (see Special Function Patterns section starting 
on page 50 for more information).

One way to rearrange the channels is to select the channel you wish to re-arrange by 
checking the box next to it.  Since only one channel can be moved at a time, you must 
make sure that only 1 box is checked.  All boxes can be unchecked by selecting De-
Select All from the Edit menu.  With the one channel you wish to reposition checked, you 
can push the lower Move Up or Move Down button to rearrange the channel.  Figure 6-5 
shows these buttons.  

Figure 6-5: Buttons for Rearranging Channels

It is also possible to move the channels with the mouse.  To do so, click on the channel 
you wish to move with the left mouse button, hold down the button and move the channel 
up or down in between the two channels where you want to reposition it.  Release the 
mouse button to drop the chosen channel into its new place.  It will immediately be 
moved from its old location to the new location in the sequence.

When you save a sequence, the channel order is embedded in the sequence file.  This 
means that the chosen sequence ordering can be recalled the next time the software is run. 
It also implies that you may have to reconfigure the ordering when change sequence files 
if you want them to look the same.

Special Function Patterns
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Instead of just manually turning on and off channels, you can also use the special 
functions feature to set waveform patterns.  To view the Special Functions screen, select 
Special Functions from the State menu.  A window similar to Figure 6-6 will appear.

As Figure 6-6 shows, there are two special functions.  The following describes each in 
detail and the options associated with it.  All special functions are only applied to the 
selected channels within the defined interval based upon the timebar location.  Before 
bringing up the Special Function screen, be sure to select the channels and time you want 
to affect.

Figure 6-6: Special Functions Window

Oscillating Pulse

This function makes all selected channels toggle at a regular rate.  All selected channels 
are identically affected.  The end result is a waveform that looks like a digital clock with 
a 50% duty cycle.  The “States before toggle” determines how often the waveform 
toggles.  For example, specifying “1” will turn the channel on and off repetitively at 
every possible time unit within the selected interval.  Setting the value to 2 will have the 
channel(s) remain on for 2 time divisions and then off for 2 time divisions.  In terms of 
time, with a 100ms resolution (10 states per second), a “1” will cause the channel(s) to 
turn on and off every 100ms and “2” will change every 200ms.

The “Initially on (high)” checkbox specifies whether the toggling should begin with the 
channels on or with the channels off.  If this box is checked, the selected channels will be 
turned on at the time where the left timebar is positioned.  If it is unchecked, it will 
remain off at this initial position.

Walking Pulse

The walking pulse function causes the selected channels to iteratively turn on for a fixed 
interval.  Multiple channels must be selected for this to be meaningful.  The time interval 
must also be wide enough to allow the desired sequencing to occur.
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The “States pulses is on” represents the number of time units that each channel will 
remain on before advancing to the next channel.  Setting it to 1 means that each channel 
will only flash on for a single time unit and then immediately turn off.  The next channel 
will then turn on as the first channel turns off.  The waveform ordering is important since 
the pulses are walked across channels from top to bottom as displayed in the Sequence 
Editor.

Figure 6-7 shows the result of walking a pulse across 6 channels with the “States pulses is 
on” set to “2”.  

Figure 6-7: Example Walking a Pulse Across 6 Channels

Normally each channel will turn on only one time.  When the last channel in the selected 
list is reached, the special function will terminate (unless the right timebar is reached 
first).  If you want the pattern to continue to be applied until the right timebar is reached, 
you can check the “Loop until end time bar” box.  With this checked, the first channel in 
the list will be turned on as the last channel is turned off and the pattern will be repeated.

The “Leave on (high)” checkbox makes it so that channels are never turned off.  Instead, 
each channel is turned on and remains on until the right timebar is encountered.

Time Stamper

When designing sequences that are carefully synchronized to music, the Time Stamper is 
probably the most useful feature.  It allows you to create a set of time stamps within the 
song.  These timestamps can then be used to turn on and off channels, set time bar 
positions, and plan your sequence.

From the Sequence Timing Editor screen, select Launch Time Stamper from the State 
menu.  This will bring up a screen similar to Figure 6-8.  Initially the list on the left will 
be completely empty.
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Figure 6-8: Time Stamper

At the bottom of the Time Stamper (Figure 6-8) is a multimedia control.  This allows you 
to control the media file you have associated with the loaded sequence.  You can use this 
control to play the song.  You can also drag the progress indicator within the player to 
skip ahead or back to different parts of the song.  Everything queues off of this player.

Normal use of the time stamper involves the following steps:

1. If the list on the left is not already cleared, press the Clear All button to clear it.
2. Start the song using the Windows Media Player control at the bottom of the Time 

Stamper.  You can reposition the progress bar to different parts of the song as 
desired.

3. Push the Monitor Keys button to begin monitoring keypresses.
4. Listen to the song and press keys on the keyboard at moments in the song of 

interest.  Both key presses and releases are monitored, so you can hold down keys 
and release them to identify key aspects of the song.  Multiple keys can be pressed 
at once too.

5. Stop the media player when you are complete.  
6. Use the controls on the right along with the timestamps placed on the list to 

modify your sequence (more details follow).
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When developing sequences, it can be useful to use the time stamper to identify key parts 
of the song.  For example, you could listen to the song and press the letter “d” whenever 
you hear a drum beat.  You could also hold down “b” whenever bells are chiming.  If the 
song has singing in it, you can hold down keys to identify portions of the song where the 
artist is singing key lyrics.  Simply release the key when the singer stops.

Tip: Sometimes you will need to listen to the song more 
than once to practice pushing keys with the time 
stamper before you are able to accurately pinpoint 
segments of interest.  It can sometimes take a try or 
two to get used to the rhythm and press the keys you 
have chosen at just the right times you desire.  If you 
are not happy with how you did, just press the Clear 
All button and try again. 

If you are unhappy with specific key presses, you can selectively remove their 
timestamps from the list by selecting them and pressing the Clear Selected button.  This 
is useful if a key was pressed by accident at the wrong time and the specific instance can 
be easily picked off in the list.

After creating timestamps for the desired portion of the song, the next step is to apply 
these time stamps to the sequence.  There are several ways that you can do this.  The 
controls on the right side of the Time Stamper are used to do this.  The following 
common scenarios describe how you can do this.

Positioning Time Bars

The easiest use of the Time Stamper is to mark points in time of interest and then position 
the time bars at those locations.  You can then return to the Sequence Timing Editor 
screen and make changes as appropriate (e.g. perhaps apply a Special Function to that 
interval).

First you must select the timestamp of interest.  To do so, click on a “Push” or “Release” 
item on the timestamp list on the left.  You can then push the Left Time Bar or Right  
Time Bar button.  The selected timebar in the Sequence Editor will be repositioned as 
specified.  You can then switch windows back to the Sequence Editor or close the 
TimeStamper to return to the other window.  Leaving it open can be helpful if there are 
other timestamps of interest.

Advanced Keystroke Patterns

You can also directly turn key presses into programmed on/off states.  You can use the 
Time Stamper to precisely identify when you want a given channel to turn on or off.  For 
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example, assume you have 3 channels in your system: a snowman, a tree, and a candy 
cane.  You can use the Time Stamper to listen to the song and press and hold down the 
“S” key whenever you want the snowman channel to be on.  Release the “S” key when 
you want the snowman to be off.  You can similarly press and release the “T” key for the 
tree and perhaps the “X” key for the candy cane.  The chosen keys do not matter, as you 
will see.  

The following procedure applies advanced keystroke patterns:

1. Play the song and press keys as previously described to create timestamps.
2. Once the song is stopped, the drop down box titled “Select Keystroke” will be 

populated with all of the keys having associated timestamps.  
3. To apply key presses to a given channel, select the key of interest from the drop 

down box.  For example, choose “S” from the list first.  
4. The next step is to select one or more channels from the “Channels to Select” box. 

Hold down CTRL or SHIFT to aid in selecting multiple channels if desired.  In 
the stated example, the “Snowman” node should be selected.  

5. The options below can be modified if needed (explained in detail later).  
6. Press the Update Waveforms button.  SyncLights will automatically turn on and 

off the selected channels based upon the timestamp data currently on the list.

These steps would then be repeated with the key “T” selected and the “Tree” channel 
chosen and the “X” key and “Candy Cane” channel identified.

Before pressing Update Waveforms, the settings just above it can be configured.  

Add Push Delay: Sometimes keystrokes can always be delayed by a fixed 
amount.  For example, you may always press and release keys after a fixed delay. 
Sometimes it can be easier to intentionally respond with delayed keystrokes.  This may 
produce less variation in reaction time and better timestamps.  By setting a push delay, all 
time stamps will be adjusted accordingly.  For example, a time stamp at precisely 0:01.00 
seconds will be treated as though it occurred at 0:00.90 (0.1 seconds earlier) if the push 
delay is programmed to 0.100.  The units of the value are shown to the right in seconds. 
For example * 0.100 indicates that each value represents 0.100 seconds.

Preserve Narrow Pulses: Normally timestamps are rounded to the nearest time 
that appears on the time grid.  This can cause very quick keystrokes to be ignored.  For 
example, a key pressed at 0:01.00 and released at 0:01.04 will not have any effect.  This 
is because both 0:01:00 and 0:01.04 round to 0:01.00.  Therefore the channel turns on and 
off at the same time.  There is no net difference and the waveforms will not change.  If 
you want very narrow pulses like this to be preserved, you can check this box.  This will 
ensure that each keypress results in a pulse that is of at least perceivable duration.  In the 
stated example, the 0:01.04 would be rounded up to 0:01.1 (assuming 100 millisecond 
resolution).

Duration of Song to Apply To:  There is also an option to Apply Pattern to 
Entire Song, Only Turn ON when pushed, or Only Turn OFF when pushed.  This controls 
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how significantly the sequence will be affected when the Update Waveforms button is 
pushed. 

• Apply Pattern to Entire Song: The selected channels will be completed erased 
and replaced with the pattern specified by your keypresses.  This will affect 
the entire song.  If you only created time stamps for the first 30 seconds of the 
song, the channels will simply remain off for the other parts of the song 
(because no timestamps were defined there).  This is usually not a desired 
choice unless you want to erase the entire existing waveform for the chosen 
channels.

• Only Turn ON when pushed: The existing waveform will be left intact.  It will 
only be adjusted by turning on the selected channel(s) whenever the chosen 
key was held down.  The channel(s) will never be turned off.  If a pattern is 
applied to a channel that is already on the entire time, there will be no 
apparent change with this option chosen.

•  Only Turn OFF when pushed: The existing waveform will again be left 
intact.  It will only be adjusted by turning off the selected channel(s) whenever 
the chosen key was held down.  The channel(s) will never be turned on.  If a 
pattern is applied to a channel that is already off the entire time, there will be 
no apparent change with this option chosen. 

Tip: It can be overwhelming to try to define timestamps for 
many keys at once or for large portions of the song. 
You may find it easier to only use a few keys at once 
and repeat the procedure to target other events.  It can 
also be useful to focus on a small section of the song 
at once.  When working with large portions of the 
song, it is easy to make a single mistake somewhere 
that may prompt you to want to start over.  Working 
with smaller segments of the song helps to avoid this. 
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CHAPTER 7

Simulating Sequences

This chapter covers simulation and how it can be used to check a programmed sequence 
without any hardware present.  This is useful for development when hardware is 
unavailable.

Simulating an Entire Sequence

It is common to want to view a programmed sequence many times during development. 
To facilitate this, SyncLights supports full simulation of programmed sequences.  To 
simulate a sequence, following these steps:

1. Save your changes to the sequence and close the Sequence Timing Editor if still 
open.

2. At the main design screen of SyncLights, select Playlist Manager from the 
Playlists menu.

3. The Playlist manager will appear (see Figure 7-1).  Press Add to add a saved 
sequence file to the playlist.  Navigate to find the sequence file you wish to 
simulate.

4. Select the sequence file from the playlist by clicking on it.
5. Make sure the “Simulate” box is checked.
6. Press Play Selected.  The Playlist Manager will disappear and the song will start 

to play.  Channels will be grayed out to indicate that they are off and colored 
when they should be on.  All channels will update in real time as the sequence 
executes with the chosen multimedia file.
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Figure 7-1: Using the Playlist Manager to Simulate a Sequence

Simulating Part of a Sequence

In defining the latter portion of the sequence, it is common to only want to simulate a 
portion of the sequence.  This is possible by setting a “Start Within Song” value within 
the simulator.  Instead of playing the entire song and sequence, the simulator starts in the 
middle of the sequence.  This avoids the need to re-watch portions of the sequence that 
are not currently under development.

Figure 7-1 shows where this option is.  Specify a value in seconds.  For example, setting 
the “Start Within Song” field to 90 would start the song and associated sequence 90 
seconds (1 minute and 30 seconds).  The simulation simply bypasses the beginning of the 
sequence.  There should be no visual difference between using this option or not using 
this option.  

If you do notice a difference, the file you may be using may be corrupt or inadequate. 
Try converting the file to another format or repairing it.  With certain damaged files, the 
returned time stamps from Windows Media Player exhibits jitter and causes slight 
variations in simulation and execution that are far from desirable.  It is recommended that 
these files are not used.
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CHAPTER 8

Hardware Interfaces

This chapter discusses the supported hardware interfaces.  Channel lists and sequences 
can be defined and simulated without specifying or connecting any hardware.  The type 
of communication to the hardware must be defined though to control actual hardware. 
The software abstractly manages different interfaces to make support of additional 
interfaces feasible.

When connecting to actual hardware, it is important to observe manufacturer 
recommendations, safety instructions, and installation tips.  Failure to do so may result in 
death or injury.  Working with electricity can be dangerous if not handled properly. 
Make sure that you follow standard safety precautions to prevent the injury of yourself 
and others.  

Always connect displays to GFCI outlets when setup outside or in damp conditions.  A 
ground fault circuit interrupt can disable power if it detects a fault.  These can guard 
against hazards where electric current is sourced by not returned on the neutral conductor. 
If current flows to ground through another means (such as through a person coming in 
contact with it), the GFCI outlet can disable power and prevent death or injury.  Please 
consult the manufacturer provided documentation and an electrician or other qualified 
personnel as needed when connecting electrical devices.

Warning:  Switching of electrical devices can pose 
hazards if not handled carefully that include 
injury or death.  Always supply power through 
tested GFCI outlets and follow other 
manufacturer recommendations to promote 
safety.  It is your responsibility as the installer 
to ensure that the system is safe and protects 
users, viewers, and other individuals from 
harmful voltages.  Remove power from the 
system whenever servicing and follow other 
manufacturer recommendations and 
requirements.

If you decide to attempt to design your own hardware, make sure that you understand the 
inherent risks of working with electricity.  Please consult an electrician or other qualified 
personnel to confirm that your system and hardware is safe.
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Specifying the Hardware Interface 

Before you attempt to execute a sequence to control actual hardware, you need to specify 
the hardware interface you will be using.  This makes sure that the software knows how 
to communicate with the connected hardware and control the defined channels.  If you 
are only planning to simulate sequences, there is no need to select a hardware interface.

It is best to specify this early on since different control channels may require different 
identifiers for the hardware.  If you change the hardware interface after creating control 
channels, you should revisit the control channel definitions and check any hardware 
fields to ensure that there is not any missing information.

To select a hardware interface, select Settings from the Hardware menu.  A window will 
appear similar to Figure 8-1.  At the top you will be able to select from a set of supported 
hardware interfaces.  Select the desired interface.  Options related to that interface will 
automatically appear below your selection.  You can modify these options and then press 
Save.  More information about the interface specific options is available in the following 
sections under the selected interface.

Figure 8-1: Specifying a Hardware Interface

There is also an optional selection to send an “all off” command when the program is first 
run.  This can be useful if the server is connected to hardware in the event of a power 
failure.  If the program is set to automatically run when the PC starts, this option will 
ensure that all channels are turned off.  Some hardware may not power up in a known 
state, so this is a useful way to help initialize the channel states.  To enable or disable 
this, select All Off on Startup from the Hardware menu.  If it is checked, this mode is 
enabled.  When it is not checked, it is not enabled.  This only has an effect when initially 
running the program.
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Parallel Port SPI Interface 

The Parallel Port SPI Interface uses the digital I/O lines on your computer’s parallel port 
to control the hardware.  The parallel port was commonly used for printers prior to the 
introduction of USB.  This interface requires a DB-25 cable.  This cable connects the 
parallel port on the back of the computer running the SyncLights software with the actual 
control hardware.  This hardware may be a commercial product that you purchased or 
custom hardware that you built.  

Figure 8-2 shows the pinout of a DB-25 connector.  It is shown from the perspective of 
the female end of a male-to-female connector.  This corresponds to the end that connects 
to the control hardware.  Figure 8-2 shows the view looking at the cable itself.  The 
pinout of the connector it mates with will actually be mirrored.  Pins are labeled from 1 to 
25 and the eight data outputs are labeled as D0 to D7.

Figure 8-2: Pin Out of a DB-25 Cable Highlighting the 8 Digital Outputs

A parallel port is limited in throughput and drive capability.  It does not offer any power 
pins, although there are ground connections.  This means that power for a voltage 
reference needs to be supplied through another connection or device.  Commercial 
hardware takes care of these limitations for you, so no action is necessary.  Data rates are 
limited to fewer than 100,000 transitions per second.  In practice this means that clock 
rates will be limited to tens of kilohertz.  This puts limitations on the length of sequences 
that can be clocked out based upon the frequency of updating the patterns.

The Parallel Port SPI uses 7 of the 8 digital outputs to implement three SPI channels. 
SPI, or serial peripheral interface, is a simple communication protocol involving a clock, 
data, and strobe signal.  Data is sent on the data line and clock transitions from high to 
low or low to high are used to separate the data values in time.  Figure 8-3 shows a 
simple SPI waveform as implemented by the Parallel Port SPI interface.  In this example, 
only 4 bits are clocked out.  Longer sequences are possible and involve more clock and 
data transitions.

The SPI protocol implements a normally high clock signal.  This means that the clock is 
high when idle.  The software generates a rising edge and then changes the data pattern. 
This ensures that hold times will easily be met and leaves the widest timing margin for 
setup times when the receiving device is rising-edge sensitive.  It is also possible to 
communicate with falling edge sensitive devices, although the setup time margin is not 
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optimal.  Even so, setup requirements nearing 10us can still be met.  Optimal support for 
falling edge devices may be added to the software at a later date by request.

Figure 8-3: SPI Data Waveform Produced by SyncLights Software

As Figure 8-3 shows, data is transmitted most significant bit first.  This has relevance 
when specifying the “Hardware Bit” field associated with each control channel.  Put 
simply, higher numbered hardware bits will get sent out first.  The documentation 
associated with your actual hardware will help you understand the implications of this.

The Parallel Port SPI Interface implements three separate SPI communication lines 
numbered 0, 1, and 2.  These are identified in the software via the “HW Comm Line” 
value associated with each channel (see the Creating a New Channel section on page 23 
or Figure 4-1).  Seven signals on the parallel port connector are used to drive these three 
channels.  A common clock is shared across all three SPI paths.  Separate strobes are 
used and slightly offset from one another to attempt to reduce simultaneous loading of the 
hardware power supplies during transitions.

Channel 0 Channel 1 Channel 2
Data 0 Data 1 Data 2
Clock * Clock * Clock *
Strobe 0 Strobe 1 Strobe 2

* A common clock signal is shared across all 3 channels

Table 8-1: The Seven Signals Used to Implement 3 SPI Channels

The exact pins used for each signal is configurable within the SyncLights software.  It is 
also possible to configure the length of SPI sequence.  Put another way, you can specify 
how many data bits are clocked out during each transfer.  When this hardware interface is 
used, you will be limited to no more independent channels than 3 times the number of 
bits clocked out.  Existing systems use up to 80 clocked bits to support up to 240 
channels.  This has been tested at rates of 10 transitions per second.  Longer sequences 
and more channels are also possible by have not been tested by the developer.
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Configuring the Parallel Port SPI Interface

There are several fields that can be configured when using the SPI hardware interface. 
All of the digital outputs pins on the parallel port connector can be chosen.  Values 
between 0 and 7 must be selected to correspond to D0 through D7 in Figure 8-2.  Recall 
that there is a shared clock that all three hardware SPI communication lines share.  The 
interface is organized similarly to Table 8-1 to highlight the separate communication 
lines.

Figure 8-4: Custom SPI Hardware Interface Options

There are also other SPI protocol options that you can set.  These include the duration of 
the strobe pulses and the delay between the clocked data and the strobe.  Figure 8-3 
shows these times explicitly.  The clock runs as fast as possible.  Since the parallel port is 
slow compared to most electronic devices, there should not be a need to slow the clock 
down.  Clock rates are typically in the tens of kilohertz (e.g. 36-10 kHz).

You can also specify the number of bits to clock out per channel.  This represents the 
number of clock pulses with accompanying data bits that will get sent.  Increasing this 
value allows more channels to be controlled.  It is important that this value is larger than 
the highest “HW Bit” value you specify across all of your control channels.  If not, the 
affected channel will never get controlled since its control bit will never be transmitted.

Lastly, you can select whether or not you want to use negative relay logic.  If you check 
this box, the software will assume that a logic ‘1’ turns off the relay and a logic ‘0’ turns 
on the relay.  By default, positive logic is assumed such that a logic ‘1’ corresponds to 
turning on a channel (via its relay).
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Additional Interfaces

Support for additional interfaces is also possible.  The software is modularized to support 
several different hardware interfaces.  If you have a different interface, support for it can 
be added by request.  To petition for another interface, please contact the developer with 
your request.  

More Information: See the Additional Feature Requests section 
starting on page 84 for more information.

Designing Custom Hardware

If you do not have hardware to control the individual channels, you can purchase it.  You 
can also design your own hardware if you are experienced and qualified to do so.  The 
information in this chapter is intended to enable you to understand the interface in 
adequate detail to build custom hardware if desired.  Due to confidentiality, not all 
supported interfaces may be fully described.  If you decide to go this route, please take 
into consideration the following tips and precautions.

• Be careful.  Working with electricity can be dangerous!
• Always power any outdoor displays using only GFCI protected circuits.
• Special notes about the Parallel Port SPI Interface

o This interface works well with relay drivers with an SPI interface.
o The parallel port cannot source much current.  You should not try to drive 

any devices with these signals directly.
• It may be a good idea to electrically isolate the communication signals leaving 

your computer before they make it to control devices.  This will protect your 
computer against damage from a fault condition.

• Keep safety in mind as you design your system.  Electricity can be dangerous.
• This can be fun, but requires knowledge and hard work. Leave adequate time for 

development and try to plan in advance to understand expected expenses before 
beginning.

• Consider purchasing a commercial system if you do not have the time, 
experience, or interest in building your own hardware.

SyncLights Player Manual Page 64 Clocking Edge Software



CHAPTER 9

Executing Sequences 

This chapter covers execution of sequences to control actual hardware.  Sequences can be 
manually loaded and run or setup to run automatically using the Playlist manager and 
scheduler.

Executing a Sequence

Executing a sequence is very similar to simulation.  The only difference is that the 
“Control Hardware” box is checked instead of the “Simulate” box.  Refer back to the 
chapter titled Simulating Sequences starting on page 57 for more information.  The 
Playlist Manager screen is brought up by selecting Playlist Manager from the Playlsits 
menu of the main design screen.

Figure 9-1: Executing a Sequence with the Playlist Manager

SyncLights Player Manual Page 65 Clocking Edge Software

1

3
4

2
5



Creating a Playlist

Playlists can be used to execute multiple sequences.  The prior section only describes 
how to run a single sequence.  When that sequence completes, no further action will be 
taken.  In contrast, playlists loop and automatically select the next sequence from the 
playlist.

To create a playlist, select Playlist Manager from the Playlists menu.  The center list 
represents the current playlist.  Items can be selected and Remove pressed to remove them 
from the list.  The entire list can be cleared by pushing Clear.  Push the Add button to add 
items to the playlist.  Navigate to select the desired sequence file and it will be added to 
the list.

Once sequences have been put on the list, the Move Up and Move Down buttons can be 
used to rearrange the sequences on the list.  Just select a sequence to move and push the 
desired button.

Saving and Opening Playlists

Once you have defined a playlist, you can save it by selecting Save Playlist from the 
Playlists menu.  You will be prompted to specify a filename to save it under.

Opening playlists proceeds similarly.  Select Open Playlist from the Playlists menu and 
then navigate to find the file to open.

Running a Playlist

Push the Run Playlist button to begin running a playlist.  The first sequence should begin 
immediately, although the playlist scheduler and related options may prevent this from 
occurring (see the Playlist Schedule section starting on page 67 for more information). 
You still need to check the “Control Hardware” and/or “Simulate” buttons.  Checking 
both will cause the hardware to update and the software to simulate the sequence.  This 
requires more processing power on your computer and is not recommended unless you 
are actually watching the simulation.  Uncheck the “Simulate” button when you finish 
watching the simulation on the screen.

The lower right section of the main design screen show status information about the song 
being played.  You can check the “Show Media Player Option” to see the media player 
progress as it plays the song.  You should not try to use this to manually adjust the 
playback.  

You can press the Stop button to stop the current playlist.  The Skip button immediately 
stops playing the current sequence and goes on to the next sequence in the playlist.
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If you check the “Randomize” option, the sequences will be randomly selected.  When 
this box is unchecked, they will be played in order as shown on your playlist window. 
The “Repeat” option causes the playlist to loop. If it is not checked, the playlist will only 
play each song once and then stop.

Playlist Schedule

You can also configure the playlist schedule to limit when the sequences are played.  If 
the “Enable Scheduler” button is checked, the sequences will only run if the computer’s 
clock is between the specified times.  The clock is checked each time a new sequence is 
started.  Once a sequence is started, the clock is not consulted.  This implies that the 
sequences will not stop abruptly at the programmed time, but no additional sequences 
will begin.  The current sequence will finish and then the system will become idle. 

The playlist scheduler can be used to automatically enable a display only during certain 
hours of the day.  Figure 9-2 shows the scheduler screen.  It has been configured to run 
every day from 18:00 (6pm) to 21:30 (9:30pm).  On Friday and Saturday night, it will 
continue to run until 22:15 (10:15pm) though without interruption since the intervals are 
adjacent in time.

Figure 9-2: Executing a Sequence with the Playlist Manager
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To use the scheduler, specify the values in the “Add Event to Scheduler” area of Figure 
9-2.  Enter a start time and a stop time using 24-hour format instead of specifying AM or 
PM.  For example: hour 0 is midnight, hour 12 is noon, hour 13 is 1pm, and hour 23 is 
11pm.  Next check the days of the week where the interval should take effect.  Finally 
press Add to Schedule and the times will get added to the schedule list.

SyncLights does not have a problem if scheduled times overlap.  For example, Figure 9-2 
could have specified 18:00 to 22:15 on just Friday and Saturday in place of the second 
entry shown.  This would work identically.  The software will run the playlist if the 
current time falls between any of the defined time intervals (and even if it falls within 
more than one).  

If you want to run a sequence past midnight, you will need to break it up into two pieces 
since stop times cannot come before start times.  Program one interval to stop at 23:59:59 
and the next interval to start at 0:0:0 on the adjacent day.

Normally seconds do not need specified unless it is important that the sequence begin 
right on schedule.  If this is the case, the “Trigger precisely on start time” box should be 
checked underneath the current playlist schedule.  If this box is checked, the software 
monitors the computer clock a couple of times per second.  Without it checked, it only 
makes a comparison every 30 seconds or so.  Checking the server’s clock more 
frequently consumes more computing resources.  It is therefore not recommended to 
request precise timing unless required.

After entering all desired start and stop times and checking the “Enable Scheduler” 
button, press the Run Playlist button (refer back to Figure 9-1, noting that this button is 
present but not circled in the figure).  The status indicators in the lower right corner of the 
main design screen will update to indicate that the playlist is running but idle waiting on 
the start time.  No further action is necessary.  Execution (as specified by the 
“Simulation” and “Control Hardware” checkboxes) will begin at the start time and 
continue through the end time.

The standard edition license of SyncLights only permits one entry in the scheduler.  This 
entry must be less than or equal to 1 hour in duration.  You can upgrade to a professional 
license to remove this restriction or manually start and stop the sequences without using 
the scheduler.

Debugging Execution

During execution, you can select Show Debug Stats from the Hardware menu.  This will 
show the time error between programmed patterns sent to hardware and the current song 
being played.  Large amounts of error can indicate a problem.  SyncLights automatically 
corrects error dynamically thoughout the song.  This ensures that a temporary problem 
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getting processing time will not permanently disrupt the sequence.  Several states may 
not get set, but the sequence should get back on track.

The following information is displayed:

Time Error: The delay between the position in the song as reported by the media 
player and the software timer used to fire sequences.  If this difference deviates 
significantly, SyncLights Player will automatically correct for it.  In rare cases, 
some poor quality media files may report inaccurate time positions and make it 
appear as thought the sequences are off (sometimes slightly ahead of schedule and 
sometimes behind from run to run of the sequence).  This is due to problems with 
the file and what it reports.  Since SyncLights Player is receiving faulty 
information due to problems with the file, it cannot detect this and the time error 
will still appear acceptable.  Try converting the file to another format or re-
recording it.

MediaPlayer Time: This is the current time position of the song as reported by 
the media player.

StopWatch Time: This is the current time of the software timer used to schedule 
sequence patterns.

Last Processed Time: The last timestamp value which was shifted to hardware. 
These times correspond to the positions programmed using the sequence editor.

Last Processed Index: The last index that was processed.  This is the same as the 
last processed time, except that it is an index into the overall number of patterns. 
For example, if the resolution is 200 milliseconds, time 0 will be index 0, time 
0.200 will be index 1, time 0.400 will be index 2, etc.

Skipped Index Count: The number of timestamp locations where the data 
pattern was never sent to hardware or simulated on the screen.  If the software 
falls behind, it will automatically skip necessary steps to catch back up.  All 
values at the later position are set, so this will often be visually unnoticeable if it 
happens fairly infrequently.  If [Skipped Index Count] / [Last Processed Index] 
is greater than a couple of percent, then it may indicate a speed problem due to 
limitations of the hardware interface or computer being used.  You may want to 
try shutting down unnecessary applications and even running a sequence at a 
lower resolution if needed.

A time error less than 0.100 seconds on average is normal.  Displaying debug stats 
consumes additional resources and should not be left running if not being used.

Try to avoid scheduling virus scans and other processor intensive activities on the server 
running SyncLights during display execution times.  This will avoid the likelihood that 
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SyncLights will not be able to control the hardware fast enough to program all specified 
states.  

Estimating Power

SyncLights is also capable of estimating power requirements and cost.  This feature is 
accessible from the Playlist manager.  It uses the current requirements specified for each 
channel (Refer back to Figure 4-1) to calculate power dissipation.  The calculation takes 
into consideration how often each individual channel is actually on.  Figure 9-3 shows an 
example of the calculated power metrics for a given sequence.

Figure 9-3: Power Estimate for a Sequence Run for 120 hours (3*40) 

There are several fields shown in Figure 9-3.  The first grouping of information appears 
at the top.  The assumptions are used to define the calculations.  These can be changed 
and then calculated values will be automatically adjusted.

You can choose how to scale the calculations.  The following options are possible:
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Calculate for Instance: This calculates the statistics for the sequence or playlist 
if executed only once.  This is not necessarily a fair estimate to use to compare with other 
configurations since it depends upon the length of the actual sequence or playlist.

Calculate per Hour: The results are normalized to assume that the specified 
sequence or playlist executes for exactly one hour.  

Calculate per Day: The results are scaled to assume that the specified sequence 
or playlist executes for multiple hours.  The number of hours is based upon the “Avg 
Hours Per Day” setting which is defined.

Calculate per Season:  This selection allows you to see results across many days. 
It assumes that the sequence or playlist executes for the specified number of days 
(“Number of Days”) with it running the specified number of hours per day.

You can also set the line voltage and energy cost.  The line voltage is fixed in the United 
States at 120VAC and need not be changed.  Other locations may need to change this. 
This value can be customized to scale the results of the calculations, which intrinsically 
assume a 120V power system.  The energy cost is the cost per kilowatt hour that is 
assumed for electricity.  This information should be available on your electric bill or by 
contacting your electric company.

Power Requirement Metrics

The power requirements section a power estimate, maximum current, and the operating 
cost.  

The power estimate takes into consideration the current specified for each of the channels 
and how often the channels are actually on.  If the channels were on all the time (without 
a switching system), the power consumption would be much higher.  The duty cycle in 
the lower section helps to describe this more directly.  The result is specified in kilowatt-
hours (wH).  Most electricity pricing uses this unit for billing.

The maximum current represents the most current that the system is simultaneously 
required to source.  It only takes into consideration the specified currents for each 
channel and determines when the most current is consumed based upon actual channel 
on/off states.  Most sequences use much less current on average than the maximum as the 
power estimate will suggest.  This information is helpful to ensure that your system does 
not exceed power supply capabilities.

The operating cost shows the cost to operate the system for the defined interval.  It is 
basically the amount entered for the kWh pricing times the number of kWh of power 
used up.
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Switching Statistics  

The software also gives some statistics on channel switching.  These include total relay 
clicks, average duty cycle, and simultaneous switching information.

The total number of relay clicks represents the total number of times that a channel is 
turned on in your system.  It is cumulative for all channels over the assumed time 
interval.  The actual sequence, or sequences in the case of a playlist, is analyzed to 
calculate this value.  Turning off a channel is not counted since it simply assumed that all 
channels must eventually be turned off.

The duty cycle represents the percentage of time that the channels are collectively on.  A 
channel that is on for ½ the song and off for ½ the song would have a 50% duty cycle.  A 
channel that is on the entire time would have a 100% duty cycle and a channel off the 
entire time would have a 0% duty cycle.  This value represents the overall average duty 
cycle of all channels across the sequence(s) being analyzed.  A lower percentage 
indicates that channels are off more often and a higher percentage indicates that they are 
on more often on average.

How to Estimate Power

You can estimate power for a sequence or for an entire playlist.  For either,

1. Select Playlist Manager from the Playlists menu.  The playlist manager will 
appear.

2. If you want to calculate power for a playlist, load that playlist.  If you want to 
calculate it for a single sequence, put the sequence on the playlist and click on it 
(just like you would if you were going to simulate or execute it).

3. From the menu of the playlist manager, go to the Estimate Power menu and 
make a selection.  Choose For Selected Sequence to base the estimate off the 
chosen channel and For Defined Playlist to calculate the power requirements of 
all sequences on the current playlist.

4. It may take a couple of seconds to perform the calculation.  Once complete, a 
window similar to 9-3 will appear.
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CHAPTER 10

Remote Control

This chapter describes how the remote controller software can be used to control your 
equipment remotely.  The SyncLights Remote Edition software runs on a secondary 
device and communicates with the primary server which is running the standard 
SyncLights software and is connected to your hardware.  This offers a convenient 
mechanism for testing hardware in the field.  A laptop or handheld device can wirelessly 
control individual channels so that they can be tested.  Sequences can also be loaded and 
executed remotely.

Network Requirements

The following is required to utilize the remote control capabilities of the SyncLights 
software:

• The server computer running SyncLights Player must be connected to an IP 
network.

• A handheld PDA or laptop with wireless IP networking capabilities (WiFi or 
802.11 support).

• A wireless IP network or a wired network capable of connecting the server 
computer and remote PDA or laptop.

The computer running SyncLights does not require any network connection for normal 
operation (assuming that the channel control hardware does not require networking).  To 
utilize remote control, this computer needs to be connected to a network so that 
commands can be sent to the server over the network.

If you are using a wireless network, it is also recommended that encryption is used to 
limit access to the network.  This prevents just anyone from running the remote software 
and trying to access your server.  Consult your wireless router for more information about 
encryption options.  

Server Software Settings

The first step is to configure the server SyncLights software that is connected to the 
hardware.  The network connection must be configured and enabled.
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Configuring the Network Connection

From within the server copy of SyncLights, select Configure from the Remote Operation 
menu from the main design screen.  A configuration screen will appear as shown in 
Figure 10-1.

Figure 10-1: Configuring the Remote Connection

The IP address is displayed at the top of the configuration screen.  The remote software 
needs to know this address for connectivity.  The port is the other portion of the 
connection or importance.  Any port address can be chosen for the server to use.  If the 
server computer has a firewall, access through the port may need enabled.  Certain 
versions of Windows may also attempt to block the software’s ability to access this port. 
This may require disabling Windows’ firewall or at least allowing SyncLights permission 
to access the network.  Any port that is available can be used though.  The key is to 
configure the same port on the remote software and on the SyncLights server software.

The network settings also require an access code.  Any value from 0 to 1,073,741,841 can 
be arbitrarily chosen provided that the same value is entered in the remote software.  This 
is used to validate the communication.  If the access code does not match, the server will 
not acknowledge or process received commands.  This is implemented for security 
purposes.

The last setting is the “Response Polling.”  This rate controls how often the server 
software checks for incoming messages.  A lower value implies more frequently 
checking.  This will result in faster responsiveness when using the remote controller 
software, but also occupies slightly more of the server’s time.  With larger values, the 
remote software may need to wait slightly longer to get a response, but the server 
software will spend less time monitoring this connection.
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Enabling Remote Access

After configuring the network connection, the next step is to enable remote access.  This 
is done by selecting Enable from the Remote Operation menu of the main design screen. 
You may receive a prompt requesting network access from the software similar to Figure 
10-2.  If you do, press “Unblock” to permit the software to use the configured network 
port to listen for remote commands.  Remote operation will not work unless you chose 
this option if prompted.

Figure 10-2: Required Network Access through Windows Firewall

Once remote access is enabled, the status indicators in the lower right portion of the main 
design screen will indicate “Remote Active”.”  When commands are received, the 
“(listening)” status will update to show “CMD RECEIVED” to indicate the incoming 
command.  Once the command has been processed, it will return to “(listening)”.  To 
disable the remote connection, select Disable from the Remote Operation menu. The 
lower status indicators will show “Remote OFF” to indicate that remote operation has 
been disabled. 

Remote Controller Software

Once the server software has been configured, the next step is to acquire and install the 
remote software.  Check the software website for more information about the remote 
software.  It is not distributed with the server software to prevent misuse of the remote 
software.

http://www.clockingedge.com/synclights/
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See the chapter entitled Remote Controller Software starting on page 77 for more 
information on using the remote software.

More Information: See the Remote Controller Software section 
starting on page 77 for more information.
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CHAPTER 11

Remote Controller Software

This chapter covers the SyncLights Remote software.  This software runs on another 
device such as a laptop or handheld PDA and communicates with the server to control the 
SyncLights software.

Supported Platforms

Presently the SyncLights Remote software is only implemented to target Pocket PC and 
Smart Phone devices.  Future development may also target Palm devices and laptop or 
desktop computers running Microsoft Windows.  If you are interested in support for 
another platform, please see the Additional Feature Requests chapter starting on page 84.

Installation

Before you begin using the remote software, you must install it.  Please follow the 
installation instructions that accompany the download or are included in the download 
link.  Once the software is installed, you can run it, configure it, and use it to 
communicate with and control the SyncLights server software.

Basic Configuration

The first step is to configure the remote software.  Figure 11-1 shows the main menu and 
configuration screen.  You must enter the IP address and the port that the SyncLights 
server software is configured to use.  The IP address should be entered in the standard 
decimal format (e.g. 255.255.255.255).  You should check the settings in the server 
software to determine what values to use.  The Server Software Settings section starting 
on page 73 describes how to look up these settings in the SyncLights program.

An access code must also be specified in the “Code” box.  This should match the “Access 
Code” set in the SyncLights server software.
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Figure 11-1: Main Screen of the SyncLights Remote Software

Once the IP address, port, and access code have been entered, the Save Configuration 
button can be pushed.  This saves these values so that they do not need re-entered each 
time the remote software is run.  Before using the software, the Run Test button should be 
pressed to establish and test connectivity.  The test will return with a pass or fail result.  If 
the test fails, the configuration should be checked.  Make sure that the both the remote 
device and server software are connected to and have access to the network.  You cannot 
use the remote software until the connectivity test passes.

After the test passes, the menu options can be used to bring up three separate screens and 
communicate with the server.

Remote Channel Control

To remotely access and control individual channels, push the Channel List Control button 
on the main screen of the remote software shown in Figure 11-1.  This will bring up the 
screen shown in Figure 11-2.  A query is sent to the server as this screen opens to see if 
the SyncLights server software is currently running a sequence.  If it is, the “Playing 
Active” checkbox will be checked.  Before individual channels can be controlled, the 
current sequence will need canceled by un-checking this box.
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Figure 11-2: Channel Control Screen of SyncLights Remote Software

The first step is to push the Query button.  The remote software will connect to the server 
and download a list of channels currently defined.  The channel names are downloaded to 
the remote device and put on the list.  An on/off indicator precedes each channel’s name 
on the list.  A prefix of [0] indicates that the channel is off.  A prefix of [1] indicates that 
the channel is on.

To remotely turn on a hardware channel, select the channel name from the list and push 
the Turn on Selected Button.  Use the Turn Off Selected button similarly to turn off a 
channel.  After making a change, you can optionally press the Query button again to 
download the updated channel list.  The on/off prefix should be updated for changed 
channels to reflect their new states.  

The All On and All Off buttons can be used to turn on or off all channels in the system at 
once.  This can be useful to quickly start off with everything in a known state so that 
channels can individually be tested.

The Close button returns to the main menu of the remote software.

Remote Playlist Control

Pressing the Playlist Control button from the main menu of the remote software will 
bring up the playlist screen shown in Figure 11-3.  This screen allows remote access to 
playlists.  It can be used to play a specific sequence or start an active playlist.

SyncLights Player Manual Page 79 Clocking Edge Software



Figure 11-3: Playlist Control Screen of SyncLights Remote Software

Push the Query button to connect to the server and download a list of sequences currently 
on the active playlist.  The listbox at the top will be populated with the names of these 
sequences.  To play a sequence on the list, select it by clicking on it and push the Play 
Selected button.

If a sequence or playlist is currently active, the Stop All button can be pressed to stop it.  

The Launch Playlist button will start the playlist currently loaded in the server software. 
Pushing the Master Playlist button will send a command to the SyncLights server 
software to load the master playlist.  It will immediately attempt to open a playlist named 
“master.xpl” that resides in the same directory as the application.  The current playlist 
will be discarded.  If this file exists, the playlist contained in it will be opened.  Push the 
Query button afterwards to see the new sequences now available on the loaded master 
playlist.

Pressing Close will return to the main menu of the remote software.

Direct Hardware Control

Pressing the Hardware Control button in Figure 11-1 will bring up the hardware control 
screen shown in Figure 11-4.  This screen can be used to directly control the hardware 
independent of defined channels.  It may not apply to all hardware interfaces.  It currently 
is intended to target the Parallel Port SPI interface.
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Figure 11-4: Hardware Control Screen of SyncLights Remote Software

When this screen is first opened, a command will be sent to the SyncLights server 
software to see if a sequence is currently being executed.  If it is, the “Playing Active” 
box will be checked.  Before the hardware can be manually controlled, this box will have 
to be unchecked to stop the current sequence.

The All On button turns on all hardware bits in the system (all possible channels, whether 
defined or not).  The All Off button turns off all hardware bits.  Pushing the Walk Thru 
button individually enables each hardware bit to briefly turn on then off.  The bits are 
walked through and individually turned on and then off as fast as the hardware interface 
will support.

The lower section of Figure 11-4 allows each hardware bit to be manually turned on or 
off.  Select the desired channel and hardware bit and then push the Turn on Bit button. 
This will turn on the potential channel that is controlled by the specified hardware bit.

The Close button returns to the main menu of the SyncLights remote software.
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CHAPTER 12

Troubleshooting

The following problems reflect common issues encountered when working with 
SyncLights.  Please check the program’s website for an up to date list of known issues 
and resolutions.  If you feel that you have encountered a software bug, please see the 
section titled Software Bugs on page 84 and report the problem to the developer. 

Problem: Upon running the application, you receive an error before the program even 
loads.  It reads something similar to the following:  “The application failed to initialize 
correctly (0xc0000135).”

Resolution: This error will occur if you try to run SyncLights and do not have the .NET 
framework installed on your computer.  You must download and install the .NET 
framework before running SyncLights.  This can be downloaded free from Microsoft.  

You can search Google.com for “download .net framework Microsoft” to find a 
download link to get the framework files from.

Problem: The SyncLights remote application will not connect to the SyncLights server 
software.  The Run Test button always fails.

Resolution:  There are many possible reasons this may happen.  The following list 
includes several common suggestions to help remedy the situation.

• Make sure that the handheld device has 802.11 WiFi network access.  
o Enter any necessary security codes to connect to your wireless network.
o Not all devices support WiFi.  There are other wireless standards that are 

different and will not work (e.g. Bluetooth).
o To save battery life, some devices turn off the WiFi feature by default. 

Ensure that it is on and test it by trying to load a webpage.
• Check the IP, port, and security code settings to ensure that they are the same on 

the server and remote software.
• Ensure that the server software has the remote connection enabled (see Server

Software Settings on page 73).
• Check that a firewall is not blocking port access to the server.  Make sure 

Windows does not block the SyncLights application from accessing the network 
due to Windows Firewall settings.
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Problem: Each time a certain song is played, the associated sequence seems to differ 
slightly.  Sometimes the timing is too soon, sometimes too late, and sometimes just right.

Resolution: You can check the Debug Stats to see if the software is at fault or if there is a 
problem with the multimedia file itself.  The debug stats report the difference between 
when the states commands are sent to hardware and when they are suppose to be based 
upon the song itself.  If this difference is small (less than 100 ms), then the issue is likely 
the song itself.  Some songs or files may not work well with the media player and report 
false time information.  Try using a different song or converting the song to a different 
file or format.

If the difference reported by the debug stats is significant, then your computer may have 
troubles keeping up.  Try closing other running applications and shutting down 
background tasks such as hard drive virus scans (schedule them for another time when 
the software is idle).

Problem: When loading a background image, not all of the image is viewable 
immediately after loading.

Resolution:  This is a known issue and occurs when you are loading images that differ in 
size significantly.  The best work around is to load the image and then exit and re-run 
SyncLights.  The image will get re-loaded automatically and should appear fully even if 
the screen is resized.

More Information: See the Software Bugs section on page 84 to 
report other issues you may have uncovered.

More Information: Also check the Frequently Asked Questions 
chapter on page 86 for additional questions.
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CHAPTER 13

Additional Feature Requests

It is anticipated that actual users of SyncLights will have needs that exceed the initial 
capabilities of the software.  The software has been designed to attempt to accommodate 
future growth.  If you would like to see a new feature, support for a new hardware 
interface, or other capabilities added to the software, please contact the developer with 
your request.  You should receive a response within a few days.  Similarly report any 
problems you encounter with the software.

Enhancements

All suggestions are welcome since they help identify where improvements in the software 
would be most worthwhile.  If possible, it is also useful to understand the extent to which 
an enhancement would help you personally.  Information about why you need it or where 
the software falls short can be helpful.  Frequently requested features may be scheduled 
for future revisions of the software.

It may also be possible to accommodate special requests.  Enhancements that are needed 
quickly, may require extensive work, involve commercial use, or may not be useful to 
general users can be negotiated.  Development fees may apply and can help sponsor 
future work on the software.  Please contact the developer to discuss further details.

If you have other special needs or interests in the software, please contact the developer 
regarding a possible arrangement that may be mutually beneficial.

Software Bugs

If you find problems with the SyncLights software, please report these to the developer. 
Also describe the sequence of events or conditions that led up to the problem.  If possible, 
include steps necessary to recreate the problem.  All software bugs will be reviewed and 
fixed as time permits.
 

Contact Information

To contact the developer with a request or other information, please email:

development@clockingedge.com
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Please specify that your request pertains to the SyncLights software in your email and 
describe the circumstances surrounding the request if possible.
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CHAPTER 14

Frequently Asked Questions

This chapter covers common questions.  It will be expanded with additional questions 
and answers in the future, so check the latest version of the manual online for possible 
updates.

http://www.clockingedge.com/synclights/

Questions and Answers

Question: How can I create a welcome message or narration to play between songs?

Answer:  Simply record the audio you wish to broadcast and then create a sequence 
associated with that audio just like you would with an actual song.  You can edit the 
sequence and turn all of the channels on, all of the channels off, or something in between 
based upon your preference.  Then just save the sequence and add it to your playlist. 

Question: How can I play one song more often than the others?

Answer:  You can play a song more often by adding it to the playlist more than once. 
For example, if you are playing songs in order (not random mode), then you could insert 
an audio welcome message sequence between each song in the playlist.  When in random 
mode, you can increase the likelihood of a song playing by adding it to the list more 
times.  For example, if you have 3 songs on your playlist and add one of them a second 
time, then two songs will each have a 25% chance (1 in 4) of being played and one will 
have a 50% chance (2 in 4). 

More Information: Also check the Troubleshooting chapter on 
page 82 for additional assistance.
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CHAPTER 15

Software Licensing

There are three versions of the SyncLights Player software.  They are all virtually 
identical with only minor licensing restrictions as described in this chapter.

• SyncLights Player Standard
• SyncLights Player Professional
• SyncLights Player Commercial

The SyncLights Player Standard edition can be downloaded and used for free.  It is only 
valid for noncommercial private use.  The professional or commercial edition is required 
for other usage. 

Licensing Options

The Standard, Professional, and Commercial editions of the SyncLights player software 
are all nearly identical.  The primary difference is in the license which stipulates what the 
software can be used for.  Aside from licensing details, the only other difference is that 
the standard edition does not include access to the SyncLights Remote software and can 
not be scheduled to run continuously.  Table 14-1 and the following discussion compares 
the licensing options in detail.

Standard License Professional 
License

Commercial License

Allowed Use Private Use for Non-
Commercial 
Applications

Public Use for Non-
Commercial 
Applications

Commercial or Non-
Commercial Applications

Trial Length Never Expires Never Expires Never Expires
Cost Free $50 (USD) Contact developer

synclights@clockingedge.com

Continuous
Operation

Scheduler is limited 
to up to 2 one hour 
intervals.  

No limitations. No limitations.

Remote 
Control 
Software

Not included. Available Available

Table 14-1: Licensing Options for SyncLights Player
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The following notes should help to clarify the licensing restrictions summarized by Table 
14-1. 

Allowed Use: 
• Private use is defined as use by an individual for private viewing limited to close 

friends and family.  If the display or application is accessible or viewable by the 
general public in any way, it does not qualify as being private under this licensing 
agreement.  Being located on private property is not sufficient to qualify as being 
private as defined in this agreement.  

• Commercial use is defined as any use of this software by a company with 
commercial interest whether or not this software is directly used for commercial 
gains.  This includes commercial installations where profit will directly derived 
from use of this software.  When applying for a commercial license, one must 
specify how the software will be used and the license will be limited to the stated 
scope.  Alternative or expanded use of the software requires written permission or 
licensing upgrades to cover additional commercial instances.

• Exception: The standard edition of the software can temporarily be used for 
evaluation purposes in public or commercial settings to ascertain its suitability. 
This is only permitted for direct evaluation purposes.  Any public use or use 
associated with direct commercial gain is limited to no more than 10 days for 
evaluation.  Commercial evaluation is permitted for up to 90 days provided that it 
is not used publicly or to generate profit beyond the stated 10 day limit.  Private 
non-commercial use is indefinitely covered by the standard license. 

Trial Length:
• The software never expires or stops working.  It can be used indefinitely provided 

that the other stated application limitations are adhered to.  
Cost:

• The software can be downloaded for free without any obligation provided that the 
licensing restrictions are complied with.

• Pricing is subject to change.  Check the software or registration site for latest 
pricing.

• Commercial licensing is based upon its actual usage.  Contact the developer with 
your intended application for more information.  Please specify whether or not 
admission or other fees will be charged in association with use of the software.

Continuous Operation: 
• The Professional or Commercial software can be run indefinitely.  The scheduler 

can be programmed to limit when sequences are actually executed.  For example, 
the software could be configured to execute a playlist from 6pm until 10pm every 
day and left to run with no other intervention required.

• The license prohibits around the clock use of the standard edition.  This includes 
situations where the software is used to play sequences more than 23 hours a day. 

• There is only one restriction built into the software.  It prevents programming the 
scheduler for more than two time intervals or for a single interval that stays on for 
more than a one hour window.  Upgrading to a profession or commercial license 
removes this restriction so that the scheduler can be completely programmed.
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Remote Control Software:
• The software can be controlled remotely using the remote control software.  For 

more information, see the Remote Controller Software chapter on page 77.
• The standard license does not include access to this optional software.

Customization or other licensing arrangements are also available.  Contact the developer 
for more information.  

Upgrading Your License

You can purchase a professional license online to increase the scope of functionality 
and/or permitted usage as described.  To do so, visit the software homepage and follow 
the link to purchase a professional license.

http://www.clockingedge.com/synclights/purchase.html

To upgrade to a commercial license, contact the developer to discuss your specific needs. 
Feel free to make other inquires regarding how this software may otherwise help you.

synclights@clockingedge.com

License Restrictions

There are additional licensing restrictions on this software that you must comply with as a 
user of it.  You may not use the software for applications outside of the stated allowed 
conditions for the type of license you were granted.  See Table 14-1 for more information 
and details.  

Redistribution, reverse engineering, decompiling, copying, reselling, using for illegal or 
unsafe purposes, or any effort to attempt to compromise this software is strictly 
prohibited.  Licenses are non-transferable without written consent from the developer. 
The developer reserves the right to change this licensing agreement at any time.  

This software comes as-is with no warrantees or disclaimers about its suitability for any 
application or its actual performance.  Clocking Edge Software cannot be held liable or in 
any way responsible for any property damage, personal injury, or death that may be 
caused related to the use of this software.  The user assumes all liability by using the 
software.  This applies even if this software plays a direct role in an incident.  It is the end 
users’ responsibility to take preventive measures to guard against all possible hazards 
including those possibly caused by any source of erroneous configuration of control 
channels.  The software should not be used in circumstances where property damage, 
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injury, or death is possible.  It is forbidden to use this software in situations where 
personal safety may be compromised.

Future advanced software features and add-ons may require additional costs or licensing 
fees.  This may include support for additional hardware interfaces, certain remote access 
software, or other features as chosen by the developer.  These features will not be 
available unless the necessary licensing fees are paid.  Individuals with existing licenses 
will not be denied previous capabilities.

The software and its documentation are copyright 2007 by Clocking Edge Software.  All 
rights are reserved.

Licensing Resources

Licensing Questions and Arrangements:

synclights@clockingedge.com

Link to Purchase a Professional License:

http://www.clockingedge.com/synclights/
synclights@clockingedge.com

SyncLights Player Manual Page 90 Clocking Edge Software

mailto:synclights@clockingedge.com
http://www.clockingedge.com/synclights/
mailto:synclights@clockingedge.com

	Introduction
	Software Overview
	Software Capabilities
	System Installation

	Quick Start Guide
	Welcome Wizard
	The Main Design Screen
	Specify a Background Image
	Define Control Channels
	Create a Sequence
	Execute or Simulate a Sequence

	Creating a Background Image
	Specifying a Background Image
	Creating a Background Image

	Control Channels
	Creating a New Channel
	Editing an Existing Channel
	Deleting a Channel
	Saving a Channel List
	Opening a Channel List
	Importing Channels from a Saved Channel List
	Copying Channels
	Hookup List
	Hardware Tester 
	A Special Note About Channel IDs

	Programmed Sequences
	Creating a New Sequence
	Saving a Sequence
	Loading a Sequence

	Sequence Editor
	Editing a Sequence
	Copying and Pasting Waveforms
	Exporting and Importing Channel Waveforms
	Rearranging Channel Waveforms
	Special Function Patterns
	Time Stamper

	Simulating Sequences
	Simulating an Entire Sequence
	Simulating Part of a Sequence

	Hardware Interfaces
	Specifying the Hardware Interface 
	Parallel Port SPI Interface 
	Additional Interfaces
	Designing Custom Hardware

	Executing Sequences 
	Executing a Sequence
	Creating a Playlist
	Saving and Opening Playlists
	Running a Playlist
	Playlist Schedule
	Debugging Execution
	Estimating Power

	Remote Control
	Network Requirements
	Server Software Settings
	Remote Controller Software

	Remote Controller Software
	Supported Platforms
	Installation
	Basic Configuration
	Remote Channel Control
	Remote Playlist Control
	Direct Hardware Control

	Troubleshooting
	Additional Feature Requests
	Enhancements
	Software Bugs
	Contact Information

	Frequently Asked Questions
	Questions and Answers

	Software Licensing
	Licensing Options
	Upgrading Your License
	License Restrictions
	Licensing Resources


